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Introduction 
Welcome to Ontrack® PowerControls™ 4.0, the mailbox recovery software that saves time, money, and 
resources when recovering Microsoft Exchange data. 

PowerControls works with your existing Microsoft Exchange server backup architecture and procedures, 
and allows you to recover individual mailboxes, folders, messages, attachments, and even calendar, notes, 
and tasks directly to your production Exchange server or any PST file. This eliminates time-consuming and 
expensive single mailbox (brick-level) backups. This powerful software also lets you search and create a 
copy of all archived email that matches a given keyword or criteria.  

The PowerControls ExtractWizard lets you restore Exchange Information Store data from tape and disk 
backups to any alternate location (e.g., machine, volume, folder), thereby eliminating the need for a 
recovery server. In contrast, most backup programs let you restore Exchange data only to the same or 
duplicate server from which it was backed up. 

About this User Guide 
This user guide shows you how to install PowerControls, how to use its commands and design features, and 
how to get help. It provides step-by-step instructions for completing specific tasks on the Windows 
platform. See the table of contents or the index to locate the pages on which particular topics are discussed. 

Use Adobe Acrobat to open the PDF version of this user guide. After you open the PDF file, click the Hand 
tool to view the table-of-contents hyperlinks in layout view. Then click a hyperlink to jump to a specific 
topic in the manual. 

Five Major Reasons for Using PowerControls 
There are five primary ways you can benefit from using PowerControls: 

Minimize the time to restore an individual mailbox. PowerControls can slash restore time, making it 
possible to restore mail items from a previous full backup directly into your production Exchange server, or 
directly into a new or existing PST file. This eliminates the need for a recovery server and the extra steps 
required to separately import mail back into Exchange or Outlook. 

Eliminate backups of an individual mailbox. PowerControls eliminates the need to back up individual 
mailboxes because they can be restored directly from an EDB file. 

Minimize the time to locate all email matching specific criteria. PowerControls includes an Advanced 
Find feature that can search across all mailboxes in an archive EDB file, rather than searching one mailbox 
at a time or bringing an old backup back online for analysis. And you can search by a variety of criteria, 
including keywords, subject, date and specific users. 

Minimize storage space and the cost required to store and archive your backups. Because you don't 
need to back up mailboxes individually doing a brick-level backup, you eliminate the backup space, cost, 
and time associated with performing brick-level backups. 

Minimize the time to back up all mailboxes. PowerControls eliminates the need to back up mailboxes 
individually. Normally, companies do a full Exchange backup, and then run a second process to back up 
"Very Important Mailboxes” (VIMs) individually as well. PowerControls eliminates this second process. 
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PowerControls 4.0 Enhancements 
PowerControls 4.0 contains all the features and benefits of PowerControls 3.10 plus these exciting new and 
improved features:  

• ExtractWizard Agent for CommVault Galaxy – This new Agent offers ExtractWizard support for 
CommVault Galaxy 5.0 and 5.9. It provides the direct method for cataloging/extracting offline and 
online Exchange backups and the advanced method to catalog/extract online Exchange backups. 

• ExtractWizard Agent for UltraBac – This new Agent offers ExtractWizard support for UltraBac 7.1 
and 8.0. It provides the direct method for cataloging/extracting offline and online Exchange backups 
and the advanced method to catalog/extract online Exchange backups. 

• PowerControls Agent for Search Within Attachments – PowerControls allows you to search 
attachment text for user-defined keywords or phrases. The Find dialog box has a new “Attachment 
Text” check box allowing you to search any combination of Attachment Text, Message Subject, 
Message Body, and Attachment File Name(s). 

• Public Folders as Target – PowerControls allows you to open public folders as a target for restoring 
public folders or messages. When restoring folders from a pub.edb database to a public folder target, 
all folder permissions and messages are transferred to the target folders. In addition, you can restore 
messages from any database source or search results to a public folder target.   

• Data Store Reporting Capabilities – PowerControls can now create data store reports. The reports 
contain statistics about the data store such as sizes and counts for attachments and messages, and may 
be generated per domain, mailbox, database, and date. The reports may be saved as tab-delimited or 
comma-delimited text files. Any data store opened as a source can be the source of a report.  

• Save Search Criteria – PowerControls now allows you to save search criteria to a file for later 
retrieval. Once you select a saved search profile, the Find dialog box populates all fields with the 
appropriate values. You can also open and edit previously saved search profiles. 

• Multiple Search Session Capabilities – PowerControls now lets you open multiple instances of the 
Find dialog box to search any combination of information stores at the same time. There is no limit 
other than system resources for the number of concurrent searches you can initiate.  

• Database Integrity Check – PowerControls now has the Database Integrity Check feature in all 
versions, which was previously available only in the Free edition. This feature allows you to perform a 
recursive read of all properties of folders and messages contained in an EDB, mailbox, or folder. It also 
allows you to perform a database structure test. 

• Command Line Date Filtering – PowerControls offers you the ability to enter a date range at the 
command line. During a restore or export operation, PowerControls restores or exports only those 
messages that fall within the specified date range. 

• Improved ExtractWizard Agent for VERITAS Backup Exec – ExtractWizard now supports 
VERITAS Backup Exec 10.0 in both Direct and Advanced modes. This brings the total support for 
VERITAS Backup Exec to include versions 8.x, 9.x, and 10.0. 

• Improved ExtractWizard Agent for HP Data Storage Protector – ExtractWizard now supports HP 
Data Storage Protector 5.5 in both Direct and Advanced modes. This brings the total support for HP 
Data Storage Protector to include versions 4.1, 5.0, 5.1, and 5.5. 

• Improved ExtractWizard Agent for Tivoli Storage Manager – ExtractWizard now supports Tivoli 
Storage Manager 5.3 in both Direct and Advanced modes. This brings the total support for Tivoli 
Storage Manager to include versions 5.1, 5.2, and 5.3. 
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System Requirements 
se PowerControls on your computer, you need the followiTo u ng hardware and software:  

• Windows 2000 Server, Windows 2000 Professional, Windows XP Professional, Windows XP Home, 

Note: The Operating Systems listed above and Microsoft Outlook are required to have the latest 

• 

• ed 
hen opening an EDB file. 

r higher screen resolution  

s supports Microsoft Exchange Server 5.5, 2000, or 2003. 

w  
(MA g reliable and consistent operation of your server. 

t  connect to an Exchange server for MAPI to 

omputer. To get full 
MAPI functionality, do the following before installing PowerControls: 

n once. 

3. For those versions of Microsoft Outlook that distinguish between “Internet Email” and “Corporate 

In
l

1. Install and configure Microsoft Outlook as described in “Configuring Microsoft Outlook.” 

 running in the background. 

3. Insert the PowerControls CD-ROM into your CD-ROM drive. 

4. The installation program will automatically start. If it does not, click Run on the Start menu, and type 
D-ROM drive. Click OK. 

or Windows 2003 Server 

• Microsoft Outlook 2000 or later  

service packs installed. 

Pentium-class processor  

• 256 MB RAM 

50 MB of free hard disk space for the installation of PowerControls. More disk space will be need
for processing log files w

• Monitor with 800 x 600 o

Note: PowerControl

Po erControls is designed to run from a Windows workstation and uses native Microsoft Messaging APIs
PI) to communicate to the Exchange Server, ensurin

Ou look must be installed and configured on the workstation to
initialize properly. PowerControls is not designed to run from an Exchange Server. 

Configuring Microsoft Outlook  
PowerControls requires that Microsoft Messaging API (MAPI) be installed on your c

1. Make sure that Microsoft Outlook is installed and has been ru

2. Set up an e-mail account on a Microsoft Exchange server. 

Email,” use “Corporate Email” when configuring Outlook. 

4. Run Outlook again, and connect to the Exchange server. 

stalling PowerControls 
Fol ow these steps to install PowerControls: 

2. Turn off any disk utility or antivirus program

D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your C

5. Follow the on-screen instructions. 
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PowerControls Editions 
PowerControls software editions are licensed based on the number of servers and mailboxes in your 

censed for use on a single server with up to 100 mailboxes and the 
Business Edition is licensed for use on a single server with up to 250 mailboxes. The Enterprise Edition is 
licensed for a customized number of servers and mailboxes. The Commercial Edition is licensed based on 

for a specified period of time.  

) file, 

environment. The Standard Edition is li

an unlimited number of servers and mailboxes 

PowerControls also offers a free edition. With this edition, you can open an Exchange database (EDB
search mailboxes one at a time, and view messages.  

PowerControls 
Edition 

PowerControls 
Feature 

Agents Feature 
EW = ExtractWizard 
PC = PowerControls 

PowerControls 4.0 100 mailbox enforcement 
Standard Edition 

• EW Agent for

PowerControls 4.0 
Business Edition 

250  
name enfor

mailbox and server
cement 

PowerControls 4.0 
Enterprise Edition 

Server name enforcement 

 Microsoft® NT Backup (included)  

• EW Agent for VERITAS Backup Exec™ (priced separately) 

• EW Agent for LEGATO NetWorker® (priced separately) 

• EW Agent for Co ightStor™ 
ARCserve® (priced separately) 

• ) 

•

or 

 

• r UltraBac (priced separately) 

•  Searching (priced separately) 

mputer Associates® Br

 EW Agent for VERITAS NetBackup™ (priced separately

 EW Agent for IBM® Tivoli® Storage Manager (priced 
separately) 

• EW Agent for HP OpenView® Storage Data Protect
(priced separately) 

• EW Agent for CommVault® Galaxy™ Backup & Recovery
(priced separately) 

EW Agent fo

• PC Agent for PST Source (priced separately) 

PC Agent for Advanced

PowerControls 4.0 
Commercial 
Edition 

Subscription enforcement •  and fully enabled All Agents included

PowerControls 4.0 
Free 

All features included and 
partially enabled (open 

copy none) 

nabled 
ce but 

• For Advanced Method: No agents are enabled 

• EW Agents will allow you to save the catalog file 

any .edb file, view all 
mailboxes, search one, 

• For Direct Method: All Agents included and partially e
(each Agent allows you to read and view from any sour
cannot extract or copy any data out) 

 
Technical Note: Pow s both Pr
mailboxes) and Publi pub.edb, erControls, a 
private store mailbox lder. Pow  file with 
more mailboxes than o sed for. For exa r 100 
mailboxes per server), and try to open an .edb file w en the 

le because it exceeds 100 mailboxes. 

erControls can proces
c Information Stores (
 = public store root fo

riginally licen

ivate Information Stores (priv.edb, containing 
containing public folders). In Pow
erControls will not open either type of .edb
mple, if you purchased the Standard Edition (fo
ith 101 mailboxes, the product will refuse to op

fi
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Enabling the Licensing Agents 
Each edition of PowerControls is distributed with nine ExtractWizard Agents and two PowerControls  

 is included with the program at no extra cost, 
 all PowerControls editions in disabled 

Agents. The ExtractWizard Agent for Microsoft NT Backup
and is enabled by default. All other Agents are shipped with
conditions and require a new license .ini file to enable them.  

ExtractWizard Agent Versions Supported Disk Backup Tape Backup 

Agent for Microsoft® NT 
Ba

All Versions .BKF Files* Microsoft Tape Format 
(MTFckup ) 

Agent for VERITAS Backu
Exec™ 

p 0.0 8.x, 9.x, and 1 .BKF Files* Microsoft Tape Format 
(MTF) 

Agent for LEGATO 
NetWorker® 

6.x and 7.x** 
 

) Files .0 (LEGATO LEGATO Tape Format 

Agent for Computer 
Associates® BrightStor™ 
ARCserve® 

es 9.x and 11.x *** 
 

.CTF (ARCserve) Fil ARCserve Tape Format 

Agent for VERITAS 
NetBackup™ 

4.5 and 5.x _C1_F (NetBackup) 
Files Tape Format 

VERITAS NetBackup 

Agent for IBM® Tivo
Storage Manager 

li®  5.3  5.1, 5.2, and .BFS and .OST Files Tivoli Tape Format 

Agent for Hewlett-Packard
OpenView® Storage Data 
Protector 

 ), 5.0, 
ata 

Protector Tape Format 

4.1 (OmniBack II
5.1, and 5.5 
 

User-Defined File 
Extension 
 

Hewlett-Packard 
OpenView Storage D

Agent for CommVault® 
Galaxy™ Backup & 
Recovery 

  5.0 and 5.9 BackupPath CommVault Galaxy Tape
Format 

Agent for UltraBac 7.1 and 8.0 Magnetic Library UltraBac Software Tape 
Format 

PowerControls Agent Versions Supported Disk Backup Tape Backup 

Agent for PST as Source Microsoft Outlook NA NA 
2000 or later 

Agent for Advanced 
Searching 

NA NA NA 

 
* Microsoft NT Backu
respective p

p BKF fil  VERITAS Backup Exec BKF files are proprietary to each 
rogram and are not interchangeable. 

 the 

 On the Help menu, click About and then click License Info. 

es and

** For Legato NetWorker 7.x backups created using Advanced File Backup, Ontrack recommends
Advanced Method for extraction. 

*** For ARCserve 11.x multiplexed backup tapes, Ontrack recommends the Advanced Method for 
extraction. 

To view the currently enabled Agents  
•
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To enable an Agent  
1. Contact a sales representative and specify which agent you wish to purchase. A license.ini file 

containing the newly enabled agent will be sent to you.  

Note: To contact a sales representative, see the contact information at the beginning of this user guide. 

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
PowerControls directory.  

The License .ini File 
All PowerControls editions require a license .ini file. The purpose of this file is to let you buy the edition 
that contains only those features you need. Each edition has a specific .ini file. Before PowerControls 
enables itself, it checks the .ini file for five things: 

• The license .ini file must be valid for PowerControls 4.0. You cannot use a PowerControls 3.10 license 
.ini file with PowerControls 4.0. Neither can you use a PowerControls 4.0 license .ini file with 
PowerControls 3.10. 

• Mailbox limit if applicable. Applies to the Standard and Business editions. 

• Server name enforcement if applicable. Allows users to open EDB files only from the licensed server 
names. Applies to the Enterprise and Business editions. 

• Subscription length if applicable. Example is customers who run computer forensics. Applies to the 
Commercial edition. 

• Agents (ExtractWizard Agents, PowerControls PST Agent) 

Note: If you have the PowerControls Standard Edition (100 mailboxes), and you attempt to open an EDB 
file with 101 mailboxes, PowerControls will not open the file. 

Tip: To view and/or change the location of the .ini file, see “Setting Preferences” on page 125.  In the 
PowerControls Preferences dialog box, click the Options tab and read the instructions for the “License file 
name” preference. 

Example of a license file: PowerControls license.ini file – Standard Edition with 3 Agents enabled 
;===================================================================== 
;Kroll Ontrack License File 
;Any modification will invalidate this file 
;Copyright Kroll Ontrack Inc. 2005 
;===================================================================== 

[Product] 
Product=Ontrack PowerControls 4.0 

[Edition] 
Standard 8cb9=7OVGKkRQnAutC3kdS3Vy5uti3qz95nM4SAimfw== 

[SLN] 
SLN=08 2004 Company A 

[Licensed Mailboxes] 
100=juUCKhVQ8gs= 
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[Licensed Agents] 
PCA3132-E943F4=7+VxKmRQwQv5CysdC3U75ohi3Ayq5iI4nwiSfwmB 

PCA AjjfwmB 
;PCA3132-E943F4 = Agent for NT Backup 
;PCA
;PCA3192-99XW9E = Agen

[AU
Checksum=641e 

es: 

es, 

ntent, such as Multipurpose 
Internet Mail Extensions (MIME) content, that protocols other than the MAPI protocol place in the 

Note: The .stm file is new to Exchange 2000. Exchange 5.5 does not contain .stm files.  

•  logs) are history files recording server activity. These files are useful in 
restoring and backing up Exchange data. All Exchange 2000 transaction logs are 5 MB in size. 

Each storage group uses its own set of transaction log files. For example, if a storage group contains 

 

itted. Whenever data is written to an EDB file from the transaction log, the EDB.CHK 
file is updated with information specifying that the transaction was successfully committed to the 

 information on page splits in Exchange 5.5 through Exchange 
2) and later, the functionality provided by .pat files is incorporated 

PCA3162-XAD9GL=7+VxKmRQwQv5Cy4dC3u75pzipaza5ig4NgjqfwmB 
3192-99XW9E=7+VxKmRQwQv5CyEdC3u75v3i3Azg5kY4S

3162-XAD9GL = Agent for CA BrightStor ARCserve 
t for PST Source 

; 

THENTICATION] 

About the Exchange Database1 
The Exchange database consists of the following fil

• .edb file (rich text database file) contains data placed in the store through Messaging Application 
Programming Interface (MAPI), as well as all the database tables that define mailboxes, messag
folders, and attachments.  

• .stm file (streaming database file) contains common Internet formatted co

store.   

.log files (transaction

five stores, all transactions for all five stores are recorded in a single series of transaction log files. You 
can determine where to locate the transaction log files for each storage group. 

• .chk (check) files are checkpoint files used for recovering (playing) data from transaction logs into
EDB files. The checkpoint is the place marker in the EDB.CHK file that indicates which transactions 
have been comm

respective EDB file. Separate Exx.chk files are maintained for each storage group using ESE 
(Extensible Storage Engine).   

• .pat (patch) files are used to record
2000 (SP1). In Exchange 2000 (SP
into Exchange log files. 

                                                           

his section is taken from Microsoft Training and Certification: Implementing and 
Exchange 2000. Workbook. Redmond, WA: Microsoft Press, 2001.   

1 The information in t
Managing Microsoft 
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Organizing the Exchange Database Files for Pow

For best results when using an online incremental or differential back
• Put the .edb and .stm files in one directo

• Put the associated log files (e.g., .log, .

erControls 

up 
ry.  

pat, .chk) in one directory.  

ies can be different. 

oes not require .stm or .log files, but you should include them to ensure that all email data 
is recovered. You may get corruption errors if these files are not present. In other words, the quality of the 

You need to use the .edb and .stm files. To ensure that all email data is recovered, you should also include 
ess 

and

Ont ides you with the following ways to get help with PowerControls: online Help and technical 
support. 

Onl  this 
information by using one of three tabs. The Contents tab offers a hierarchical view of the contents of the 
user d 
way

 s
 

• 

• 

Note: The two director

PowerControls d

recovery is better if you include the .stm and log files. 

If you are using an offline backup 

all .log files, as well as .pat and .chk files if they exist. PowerControls performs its own verification proc
 will include the .log and .pat files to determine if it needs them to recover the data. 

Getting Help 
rack prov

Online Help 
ine Help includes all of the information in the user guide and more, and it lets you quickly access

 guide. The Search tab offers a full-text search of the user guide. The Index tab offers a keyword-base
 to get to specific topics. 

To tart online Help 
Do one of the following: 

Click the Help menu and then click Contents. 

Click  on the toolbar. 

• Press the F1 key. 

To identify a tool or control 
• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the item. 
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Technical Support 
If you have questions or problems not answered in the user guide or the online 
Support group. When reporting an issue, please include any information that m

Help, call our Technical 
ight help us diagnose the 

 helpful: 

ick About). 

hat you are running. 

 the problem. 

f any appeared), and the contents of the Details dialog box. 

Contact Information 
ation” and “International Contact Information” at the beginning of this user guide. 

entions in this Manual 
he following guidelines for documenting menu commands and shortcuts; commands 
ut menu; and notes and tips. 

g conventions for documenting menu commands and shortcuts: 

   Describes 

 Target PST, and then Choosing the Create New command on the Target  
click Create New.    PST submenu on the File menu. 

On the Edit menu, click Paste Special. Choosing the Paste Special command on the Edit 
menu. 

urce EDB) Holding down the Ctrl key and the S key at the same 
time and then releasing them.  

  Clicking the right mouse button.  

Shortcut Menu 
You can access many of the same commands available on the menu bar and toolbar by right-clicking the 
mouse to display a shortcut menu. The contents of the shortcut menu depend on whether you right-click in 
the Source or Target pane. This manual seeks to teach you how to use commands on the menu bar and 
toolbar, and doesn’t always specify when you can use the shortcut menu. Once you become familiar with 
PowerControls, the commands available to you on the shortcut menu should become apparent. 

problem. The following details are often the most

• The version of PowerControls you are using (on the Help menu, cl

• The versions of Windows and Outlook t

• The version of Exchange that contained the source EDB file. 

• The circumstances and sequence of steps that led to

• The text of the error messages (i

• A list of other Windows programs that you were running when the error occurred. 

See “U.S. Contact Inform

Conv
This manual uses t
available on shortc

Menu Commands and Shortcuts 
This manual uses the followin

Example  

On the File menu, point to

Press Ctrl+S (Open So

Right-click   
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Notes and Tips2 
Notes (including cautions, important notes, tips, and warnings, as well as general notes) call the user's 
attention to information of special importance or information that can't otherwise be suitably presented in
the main text. 

 

t tant points of the main 
text. A note supplies information that may apply only in special cases—for example, memory limitations, 

ui  of a program. 

p he text to their specific needs. A tip 
sugg  understand the benefits and 

a ing of the text. 

u  of data. 

Ontrack periodically improves PowerControls—adding features, making changes based on customer 
so known as patches) are available to you, 
tes. 

asyUpdate provides you with a list of options—you can 
update everything, or select a subset of options. 

 you purchase and install PowerControls, just in case there 

tton, and the
PowerControls, and then click EasyUpdate

ons. 

No e indicates neutral or positive information that emphasizes or supplements impor

eq pment configurations, or details that apply to specific versions

Ti  helps users apply the techniques and procedures described in t
ests alternative methods that may not be obvious and helps users

cap bilities of the product. A tip is not essential to the basic understand

Important Note provides information essential to the completion of a task. Users can disregard 
information in a note and still complete a task, but they should not disregard an important note. 

Ca tion advises users that failure to take or avoid a specified action could result in loss

Updating PowerControls 

requests, and fixing problems. When these updates (al
EasyUpdate™ can download and install them in minu

If there are multiple components for updating, E

We recommend running EasyUpdate as soon as
is a program patch that was not included with your version. 

To run EasyUpdate 
1. Do one of the following: 

• In PowerControls: On the Help menu, click EasyUpdate.  

• In Windows: Click the Start bu n point to Programs. Point to Ontrack, point to 
. 

2. Follow the on-screen instructi

                                                           

2 The information in this section is taken from the Microsoft Manual of Style for Technical Publications, 3rd 
Edition. Redmond, WA: Microsoft Press, 2002.   
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Chapter 1: Using the ExtractWizard 
Direct Method 
If you have not yet extracted backed-up Exchange Information Store data, try using PowerControls 
ExtractWizard. The ExtractWizard extracts both private and public Exchange Information Store data from 

hout 
are is 

or more 

Note: For information on using the Advanced Method of extracting backed-up Exchange data, see 
hod.” 

ols, and 
e wizard.  

tape and disk backups to any alternate location (e.g., machine, volume, folder), thereby eliminating the 
need for a recovery server. In contrast, most backup programs let you restore Exchange data only to the 
same or duplicate server from which it was backed up.  

The Direct Method of extracting backed-up Exchange data reads the tape or disk file directly wit
needing the original backup software installed. This method is useful if the original backup softw
unavailable and you know the tapes on which the Exchange Information Store backups reside. F
information, see “ExtractWizard: Method of Extraction” on page 12. 

”Chapter 2: Using the ExtractWizard Advanced Met

ExtractWizard: Welcome Page 
1. Click the Start button, and then point to Programs. Point to Ontrack, point to PowerContr

then click ExtractWizard. The first page describes th

 

he Licensing Agents” on page 5. 

 Click Next. 

2. (Optional) To change the location of the license file, click About and then click License Info. Under 
License File Name, specify a new location. The license file controls which ExtractWizard agents are 
active. For more information, see “Enabling t

3.
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ExtractWizard: Method of Extraction 
The second page of the ExtractWizard offers two methods of extracting backed-up Exchange data. 

 

ct Method  
Direct Method reads the tape or disk file directly without needing the original backup software 

alled. This method is useful if the original backup software is unavailable and you know the tapes on
ch the Exchange Information Store backups reside.  

e Direct Method has the following requirements: 

The tape drive must be directly attached to the computer and configured and active in the Windows
Device Manager. 

The latest Windows drivers supplied directly from the manufacturer of the tape drive hardware sho
be installed for best results. 

Both online and offline Exchange backups are supported. 

As ExtractWizard reads tapes one at a time, you must manually insert and eject each tape when 
prompted 

If ExtractWizard is installed on your backup server, make sure the services for the backup software
disabled.  

Dire
The 
inst  
whi

Th

•  

• uld 

• 

• 

•  are 
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Advanced Method 
The ExtractWizard Advanced Method uses your existing backup software to extract an Exchange da
from a backup server or tape library, across the network, to the computer running ExtractWizard. Th

tabase 
e 

ions 
m the 

our 

on 

tial 

d 

2. Click Next. 

Advanced Method takes full advantage of your backup software’s knowledge of individual set locat
and robotic library support. This is the fastest method to extract an Exchange Information Store fro
most recent backups managed by your backup server. 

Once configured for the Advanced Method, ExtractWizard seamlessly integrates with your backup 
software and fully supports your existing catalogs, backups, and tape library. No other changes to y
existing backup architecture or settings are required. 

The Advanced Method offers two choices: the API method of extraction and the Exchange Emulati
method of extraction. They share the following requirements: 

• Only online Exchange backups are supported. This includes full, copy, incremental, and differen
backups. 

• The backup client software must be installed on the computer running ExtractWizard. 

Note: The Exchange Emulation method has additional requirements. For information on using the 
Advanced Method of extracting backed-up Exchange data, see Chapter 2: “Using the ExtractWizar
Advanced Method.” 

To use the direct method of extracting backed-up Exchange data 
1. Select the Direct Method option. 
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ExtractWizard: Exchange Information Store Extraction 
Source 
On the next page of the ExtractWizard, select the Exchange Information store extraction source. 

 

e of the following: 

• Select Extract from Disk. Then type the extraction source file path, use the history drop-down menu, 
or browse to it. Click Next. 

• Select Extract from Tape. Then insert a backup tape in your tape device and, if desired, select the 
Enable Prescan option for more accurate time estimates. Click Next.  

If the ExtractWizard cannot locate a tape in the selected device, it will prompt you to insert the tape. If 
you have more than one tape device connected to your system, another screen will appear. Select the 
device containing the tape. 

• Select Use ExtractWizard Catalog. Then browse to a previously created catalog file, or use the 
history drop-down menu. Look for the .ewc extension on the file. Click Next. In order to select this 
option, you must have previously created one or more ExtractWizard catalog files. For information on 
creating an ExtractWizard catalog file, see “Saving an ExtractWizard Catalog File” on page 26.  

Notes:  
• ExtractWizard requires that the tape drive be configured and active in the Device Manager. 

• ExtractWizard works best with Windows drivers supplied directly from the manufacturer of the tape 
drive hardware. 

• If ExtractWizard is installed on your backup server, make sure the services for the backup software are 
disabled. 

Do on
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ExtractWizard: Catalog Performance Options 
The Catalog Performance Options page of the ExtractWizard offers three options for cataloging 

pes that 
ups, 

Exchange backup data sets. All three of the options will automatically skip over known backup ty
do not contain Exchange Information Store files. These types include registry backups, SQL back
UNIX backups, image backups, NetWare backups, Macintosh backups.  

 

 c
1. ptions. Note that all four options will skip known non-Exchange backups 

(e.g., registry, SQL, Unix, Mac, Netware). 

 catalog only known online 
Exchange backup datasets. It will skip all other types of backups. If the backup type is unknown, it 

ffline Exchange backup datasets: This option will catalog known online 
and offline Exchange backup datasets. If an unknown backup type is encountered, Extract 

tion 

ted 
by commas, in the box. This option is available only if the Legato agent is installed and you 
selected a tape source. ExtractWizard will catalog only the SSIDs listed. When ExtractWizard 

in 
f a span set. If you select a specific SSID search on a non-Legato tape, it will behave 

To hoose a catalog performance option 
Select one of the following o

• Catalog Online Exchange backup datasets only: This option will

will be skipped. 

• Catalog Online and O

Wizard will catalog it just in case it is a new backup identifier for Exchange backups. This op
is slower because it will catalog more types of backups.  

• Catalog SSID for Legato NetWorker only: Enter a specific SSID or a list of SSIDs, separa

detects the end of the SSIDs in the list, it will stop immediately and rewind the tape.  

The third option greatly increases the catalog speed for Legato users who want to start on a tape 
the middle o
identically to the second option (Catalog Online and Offline Exchange backup datasets). 
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• Catalog specific object ID for IBM Tivoli only: Enter a specific object ID or
separated by commas, in the box. This option is available only if the IBM Tivo

 a list of object IDs, 
li agent is installed. 

he 

s who know the Object ID of 
the backup they wish to extract. If you select a specific Object ID search on a non-Tivoli tape, it 

 

 job 
y 

ata 
stop 
eatly 

he 
-to-disk 
e 

ExtractWizard will catalog only the object IDs listed. When ExtractWizard detects the end of t
object IDs in the list, it will immediately stop processing.  

The fourth option greatly increases the catalog speed for Tivoli user

will behave identically to the second option (Catalog Online and Offline Exchange backup
datasets). 

• Catalog specific job ID for CommVault Galaxy only: Enter a specific job ID or a list of
IDs, separated by commas, in the box. This option is available only if the CommVault Galax
agent is installed. ExtractWizard will catalog only the sessions associated with the Job IDs 
entered, both online and offline sessions. ExtractWizard will be unable to know when all d
associated with the Job ID has been processed; therefore, ExtractWizard will be unable to 
cataloging early and will still need to process the entire tape. Using this option will still gr
increase the speed of the catalog, because all other sessions can be quickly skipped over.  

The fifth option greatly increases the catalog speed for CommVault Galaxy users who know t
job IDs of the backup they want to extract. This option also applies to CommVault backup
files. If you select a specific job ID search on a non-CommVault Galaxy tape, it will behav
identically to the second option (Catalog Online and Offline Exchange backup datasets). 

2. Click Next. 
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Ex a
The Cat
the disk  disk backup is much faster than 
cataloging a full tape. During cataloging, the ExtractWizard can be in one of four states: initializing, 
reading 
In additi
informat

Do one of the following:  

• Clic  
will

• Wh

tr ctWizard: Catalog Progress 
alog Progress page of the ExtractWizard shows the catalog progress. The ExtractWizard catalogs 
or tape and locates the Information Store data. Cataloging a

(processing one block at a time), scanning (seeking ahead multiple blocks), and rewinding.  
on, CommVault Galaxy Backup & Recovery displays a pre-cataloging stage (i.e., reading session 
ion from the backup) after the initializing stage. 

k Cancel if you want to stop the catalog process. If you click Cancel, the ExtractWizard catalog
 display all files that it found to that point. 

en the catalog is completed, click Next to proceed to the next page of the ExtractWizard. 
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ExtractWizard: Exchange Information Store Selection 

p. 

Step 2: Extracting an Online or Offline Backup 

Step 3: Saving an ExtractWizard Catalog File 

Step Selection 

on 

s. Each 
achine 

On the Exchange Information Store File Selection page of the ExtractWizard, you can select both the 
private and public Exchange Information Store files that you want to extract from an Exchange backu
This page of the wizard requires you to perform four steps: 

Step 1: Viewing an Exchange Backup 

 4: Completing the Exchange Information Store 

Step 1: Viewing an Exchange Backup  
1. On the left side of the window, click the plus sign (+) next to a backup set to view its volumes.  

2. Select a volume (select its name, not its check box) to display the Exchange Information Store Files 
the right side of the window.  

In the illustration below, the Microsoft NT Backup contains four backup sets and five volume
backup set lists the session day and time (e.g., 8/29/2003 12:34 AM). Each volume lists the m
name and volume name (e.g., EXCH 2003\Second Storage Group). 

 
Viewing a full online disk backup (Microsoft NT Backup) 
 

Four full 
online  

backup sets 
(Microsoft  

NT Backup) 
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Step 2: Extracting an Online or Offline Backup 
After viewing the Exchange backup sets and information store files, you can select the files you want to 
extract. When viewing and selecting files, keep in mind the following points: 

• Microsoft NT Backup, VERITAS Backup Exec, VERITAS NetBackup, and IBM Tivoli Storage 
up sets for both disk and tape backups. 

and LEGATO NetWorker can contain only one backup set 

To extract a full online (normal) backup 
 ExtractWizard, select the .edb, .stm, 

and .log files, as well as .pat files, if they exist.  

p (Microsoft NT Backup) 
ists 

the session day and time (e.g., 8/29/2003 12:34 AM). Each volume lists the machine name and volume 

Manager can contain multiple back

• Computer Associates BrightStor ARCserve 
for disk, but multiple backup sets for tape. 

• On the Exchange Information Store File Selection page of the

Example 1: Extracting a Full Online Disk Backu
A Microsoft NT Backup to disk can contain multiple backup sets and volumes. Each backup set l

name (e.g., EXCH 2003\Second Storage Group).  

 
Extracting a full online disk backup (Microsoft NT Backup) 

Four full  
online  

backup sets 
(Microso

NT Backup)
ft  
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Example 2: Extracting a Full Online Disk Backup (Computer Associates BrightStor ARCserve) 

he 
A Computer Associates BrightStor ARCserve backup to disk can contain only one backup set and 
volume. The backup set lists the session day and time (e.g., 8/21/2003 2:36 PM). Each volume lists t
machine name and volume name (e.g., Exch2003\First Storage Group). 

b
(CA B

A

One full  
online  

ackup se
rightSto
RCserve

t 
r 
) 
 
Extracting a full online disk backup (Computer Associates BrightStor ARCserve) 
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Example 3: Extracting a Full Online Tape Backup (LEGATO NetWorker) 
A LEGATO NetWorker backup to tape can contain multiple backup sets and volumes. The backup
lists the SSID (e.g., 4248031095). The volume lists the machine name and volume name (e.g., 
Exch2ka\IS). 

 set 

N

b
(

N

F

etWorker) 

our full 
online 

ackup sets 
LEGATO 

 

 
Extracting a full online tape backup (LEGATO NetWorker) 
Three full 
online  

backup sets 
(VERITAS 
etBackup) 
 
Extracting a full online tape backup (VERITAS NetBackup) 
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To e
• 

ckup. 

xtract the last full online and every incremental backup 
On the Exchange Information Store File Selection page of the ExtractWizard, select all of the files 
(e.g., .edb, .log, .stm, .pat) from the last full online (normal) backup, plus the .log files from every 
incremental ba

 
Extracting the last full online plus every incremental backup to disk (Microsoft NT Backup) 

 

 

One full  
online  

backup set  

Three 
incremental 
backup sets 
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To extract the last full online and last differential backup  
• On the Exchange Information Store File Selection page of the ExtractWizard, select all of the files 

(e.g., .edb, .log, .stm, .pat) from the last full online (normal) backup, plus the .log files from the last
differential backup. 

 

 
Extracting the last normal plus the last differential backup to disk (Microsoft NT Backup) 

To extract an online copy backup (plus every incremental or last differential)  
Use e same procedure for extracting a copy backup as you do for extracting a full online backup. A copy 
backup also works the same as a full online backup when extracting a copy backup plus every incremental 
or last differential backup. For more information see the following topics: 

• “To extract a full online (normal) backup” on page 19. 

• “To extract the last full online and every incremental backup” on page 22. 

• “To extract the last full online and last differential backup” on page 23. 

Note: The only difference between a full online backup and a copy backup is the following: For a full 
online backup, the .log files are truncated. For a copy backup, the .log files are not truncated. 
 

 th

One full  
online  

backup set  

Two 
differential 
backup sets 
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About Extracting a Full Offline Backup 
The ExtractWizard works the same for an offline backup as it does for an online backup. There are four 

rences between an offline backup and an online backup:  diffe

1. For an offline backup, you need to extract the .edb and .stm files. To ensure that all email data is 

2. An offline backup can contain a .chk file. 

The name of the volume for an offline backup displays the drive letter. 

The volume for an offline backup extracts the full path for the Information Store files. 

 extract a full offline backup 
On the Exchange Information Store File Selection page of the ExtractWizard, select the .edb and 
.stm files. To ensure that all email data is recovered, you should also select .log files, as well as .pat 
and .chk files if they exist. 

recovered, you should also include all .log files, as well as .pat and .chk files if they exist. 
PowerControls performs its own verification process and will include the .log, .pat, and .chk files to 
determine if it needs them to recover the data. 

 

3. 

4. 

To
• 

 

 

About Extracting a Backup from Exchange 5.5 vs. Exchange 2000/2003  
Extracting data from Exchange 5.5 works the same way as extracting data from Exchange 2000/2003. 
However, when you are selecting files to extract on the Exchange Information Store File Selection page 
of the ExtractWizard, you will notice two differences:  

• Exchange 5.5 through Exchange 2000 (SP1) contain .pat (patch) files in their information stores, 
whereas Exchange 2000 (SP2) and later do not contain .pat files in their information stores.  

One full  
offline  

backup set  

Extracting a full offline disk backup (Microsoft NT Backup) 
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In Exchange 5.5 through Exchange 2000 (SP1), the .pat files are used to record information on page 

.5 

Usin ault Galaxy Backup & Recovery 
box for CommVault users. Duplicates can occur when 
 select this check box, and if duplicates exist, they will 

owerControls encountered a 
b  saves time by allowing you to 
r ng a full 
r

splits. In Exchange 2000 (SP2) and later, the functionality provided by .pat files is incorporated into 
Exchange log files. 

• Exchange 2000/2003 information stores contain .stm files in addition to the .edb files. Exchange 5
does not contain .stm files. 

g the “Show Duplicates” Option for CommV
ExtractWizard has a “Show Duplicates” check 
CommVault Backup fails and restarts. You can
appear on the right side of the ExtractWizard window. If ExtractWizard or P
pro lem with a file, you can then attempt to extract its duplicate. This feature
ext act only that file (i.e., its duplicate) which encountered the problem, instead of performi
ext action of all of the files in the session.  

 
Selecting the “Show Duplicates” check box for CommVault users 

 use the “Show Duplicates” Option for CommVault Galaxy Backup & Recovery 
Select the Show Duplicates check box. If duplicates exist, they will appear on the right side of the 
ExtractWizard window.  

To
1. 

2. ms in ExtractWizard or PowerControls, and 
lick Next. 

Select the duplicate(s) of the file(s) that encountered proble
c

Duplicate files for 
CommVault Galaxy 
Backup & Recovery 

3. Complete the remaining steps of the ExtractWizard. 
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Ste
The
Sav ns that the next time you extract from that tape or backup disk, you can skip the 

To save an ExtractWizard Catalog File 
lect the files you 

p 3: Saving an ExtractWizard Catalog File 
 catalog file saves all the information that ExtractWizard needs to extract from a backup disk or tape. 
ing a catalog file mea

catalog process.  

1. On the Exchange Information Store File Selection page of the ExtractWizard, se
want to extract, and then select the Save ExtractWizard Catalog File check box. 

2. Browse to the desired location, type a file name, and click Save. Note that the catalog file is not saved 
until you click Next. 

 

tore Selection 
On the Exchange Information Store File Selection page of the ExtractWizard, make sure you have 

rd catalog file, if 
i

Step 4: Completing the Exchange Information S

selected the Information Store Files that you want to extract, and saved the ExtractWiza
des red. Then click Next to proceed to the last page of the wizard.  
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ExtractWizard: Exchange Information Store Destination 

nge Information Store Destination Folder page of the ExtractWizard, type the path 
where you want ExtractWizard to extract the data, use the history drop-down menu, or browse to the 

e. (The Browse window lets you create a new folder on the target 

2. access rights to 

Folder 
1. On the Excha

desired location and type the file nam
volume, unless you are running Windows NT 4).  

Click Next. The ExtractWizard verifies that you have enough disk space as well as 
create files and directories. 
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ExtractWizard: Exchange Information Store Copy 
Progress 

Extr
take

The top bar indicates the progress for the file that is currently being extracted. The bottom bar indicates the 
g

betw ed.  

During
blo

The Exchange Information Store Copy Progress page of the ExtractWizard shows the progress of the 
actWizard extracting the Exchange Information Store data to the destination folder. This process may 
 some time.  

pro ress for all of the files. For LEGATO and NetBackup tapes, the top bar may switch back and forth 
een files if they are interleav

 file extraction, ExtractWizard can be in one of four states: initializing, reading (processing one 
ck at a time), scanning (seeking ahead multiple blocks), and rewinding. 

 

Note: You can click Cancel to stop the process. The file currently being extracted will be deleted, but you 
can access any files that have completed extraction.  
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ExtractWizard: Completing the Wizard 
The last page of the ExtractWizard displays all of the files that were successfully extracted. If you are 
satisfied with the results, click Finish. 

 

If you extracted multiple data sets, see “Organizing the Extracted Files for PowerControls” below. 

Organizing the Extracted Files for PowerControls 
For best results when using an online incremental or differential backup 
• Put the .edb and .stm files in one directory.  

• Put the associated log files (e.g., .log, .pat, .chk) in one directory.  

Note: The two directories can be different. 

PowerControls does not require .stm or .log files, but you should include them to ensure that all email data 
is recovered. You may get corruption errors if these files are not present. In other words, the quality of the 
recovery is better if you include the .stm and log files. 

If you are using an offline backup 
You need to use the .edb and .stm files. To ensure that all email data is recovered, you should also include 
all .log files, as well as .pat and .chk files if they exist. PowerControls performs its own verification process 
and will include the .log and .pat files to determine if it needs them to recover the data. 

Note: Exchange 5.5 does not use .stm files. 
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Advanced Method 
The ExtractWizard Advanced Method uses your existing backup software to extract an Exchange database 
from a backup server or tape library, across the network, to the computer running ExtractWizard. The 
Advanced Method takes full advantage of your backup software’s knowledge of individual set locations 
and robotic library support. This is the fastest method to extract an Exchange Information Store from the 
most recent backups managed by your backup server. 

Once configured for the Advanced Method, ExtractWizard seamlessly integrates with your backup 
software and fully supports your existing catalogs, backups, and tape library. No other changes to your 
existing backup architecture or settings are required. 

Note: For information on using the Direct Method of extracting backed-up Exchange data, see  
“Chapter 1: Using the ExtractWizard Direct Method.” 

ExtractWizard Advanced Method: Two Modes of Operation 
The ExtractWizard Advanced Method offers you two choices: 

• API Method: ExtractWizard communicates directly with the backup software server through methods 
provided by the client side .dll files. The API method is used for these types of backup software:  

⇒ IBM Tivoli Storage Manager 

⇒ Legato NetWorker  

• Exchange Emulation: ExtractWizard appears as an Exchange server to the backup software. You run 
the backup software and extract the Exchange data to the computer running ExtractWizard. The 
Exchange Emulation method is used for these types of backup software:  

⇒ Microsoft NT Backup 

⇒ HP OpenView Storage Data Protector 

⇒ VERITAS Backup Exec 

⇒ VERITAS NetBackup 

⇒ Computer Associates BrightStor ARCserve 

Requirements for Using the ExtractWizard Advanced Method  
The API and Exchange Emulation advanced methods share two main requirements: 

• Only online Exchange backups are supported. This includes full, copy, incremental, and differential 
backups. 

• The backup client software must be installed on the computer running ExtractWizard. 

Note: The Exchange Emulation method has additional requirements. For more information, see page 44. 
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Using the API Method 
The API method of extracting backed-up Exchange data allows ExtractWizard to communicate directl
the backup software server. ExtractWizard queries the 
the backup software APIs (Application Program Interf

y to 
backup server for online Exchange backups using 
ace). You then select which backups you want 

extracted and ExtractWizard will extract the databases to the desired location on disk.  

puter that will be running ExtractWizard. 

point to 
e first page describes the wizard.  

The API method is used for two types of backup software:  

• IBM Tivoli Storage Manager 

• Legato NetWorker  

Using the API Method for IBM Tivoli Storage Manager  
1. Install the IBM Tivoli client software on the com

2. Start ExtractWizard. Click the Start button, and then point to Programs. Point to Ontrack, 
PowerControls, and then click ExtractWizard. Th

 

3. n of the license file, click About and then click License Info. Under 

The license file controls which ExtractWizard agents are active. For more information, see “Enabling 

(Optional) To change the locatio
License File Name, specify a new location.  

the Licensing Agents” on page 5. 

4. Click Next. 
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The Method of Extraction page of the ExtractWizard offers two methods of extracting backed-up 
Exchange data. For more information on these two methods, see page 12. 

 

5. Select the Advanced Method option. 

6. Select IBM Tivoli Storage Manager from the drop-down menu. 

7. Click Next. 

The Connection Parameters page of the ExtractWizard lets you specify the backup server and client 
computer names.  

 
Connection parameters for IBM Tivoli Storage Manager 



Chapter 2: Using the ExtractWizard Advanced Method 

8. 

• For Backup Server, enter the name of the computer on which the backup server software is 

Information Store. 

 for instructions. 

 for instructions. 

, select the 

tractWizard 

Specify the connection parameters: 

installed. 

• For Client Node, enter the IBM Tivoli client node that backed up the Exchange 

• For Password, enter the client password. 

• For Protocol, select one of the following options: 

⇒ TCP/IP Port: Refer to your IBM Tivoli Storage Manager user guide or help

⇒ Named Pipe: Refer to your IBM Tivoli Storage Manager user guide or help

• For Only catalog Exchange databases that were backed up in this time period
desired time period. 

The Catalog Progress page of the ExtractWizard shows the catalog progress. The Ex
queries the Tivoli backup server database for Information Store backups.  

 

Do one of the following:  

• Click Cancel if you want to stop the catalog process. If you click Cancel, the Ex
catalog will display all files that it found to that point. 

• When the catalog is completed, click Next to proceed to the next page of the Extr

9. 

tractWizard 

actWizard. 
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The Exchange Information Store File Selection page of the ExtractWizard lets you select both the 
private and public Exchange Information Store files that you want to extract from an Exchange 

In the following example, IBM Tivoli Storage Manager contains multiple backup sets and volumes. 

computer name and volume name (e.g., EXCH 2KA\STMUser). The objects belonging to the volume 
ject contains the log files, and the other object contains 

the .e

an incremental or differential backup. 

backup.  

Each backup set lists the session day and time (e.g., Feb 08 14:01:29 2005). Each volume lists the 

appear on the right side of the window. One ob
db and .stm files. 

Note: An asterisk (*) next to a backup indicates that it is 

 
Extracting a full online disk backup (IBM Tivoli Storage Manager) 

On the left side of the window, click the plus sign (+) next to a backup set to view its 

Select a volume (select its name, not its check box) to display the Exchange Informati
on the right side of the window.  

Select the check boxes next to the objects containing the .log, .edb, and .stm, files, as wel
if they exist.  

One full online  
backup set 

(IBM Tivoli 
Storage 

Manager)  

10. volumes.  

11. on Store objects 

12. l as .pat files, 

 

 

 

13. Click Next.  
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The Exchange Information Store Destination Folder page of the ExtractWizard lets you select a 
folder for the extracted files.  

 

Under Destination Folder, specify a location for the extracted files.  

Click Next. The ExtractWizard verifies that you have enough disk space as well as acce
create files and directories, and then begins to extract the Exchange Information Store 
selected. 

The Exchange Information Store Copy Progress page of the ExtractWizard shows t
the ExtractWizard extracting the Exchange Information Store data to the destination fo

14. 

15. ss rights to 
files you have 

he progress of 
lder. This 

process may take some time.  
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16. be 
 files that have completed extraction.  

tracted.  

(Optional) Click Cancel only if you want to stop the process. The file currently being extracted will 
deleted, but you can access any

The last page of the ExtractWizard displays all of the files that were successfully ex

 

18. acted multiple data sets, see “Organizing the Extracted Files for PowerControls” on page 29. 

17. If you are satisfied with the results, click Finish. 

If you extr
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Using the API Method for Legato NetWorker  
re you use the API Method for Legato NetWorker, you must do the foBefo llowing: 

• ote 
. 3) Right-

e Remote tab, 
trols.com 

• e files. If you do 
traction progress.  

1. 

2. rack, point to 

Make sure your current login has remote access to the client you are restoring to. To gain rem
access, perform these steps: 1) Run NetWorker Administrator. 2) Select Manage Clients
click the Exchange client you wish to restore the database from and click Edit. 4) In th
enter your full user name in the Remote Access box. Example: postmaster@powercon

Make sure your login has Legato administrative rights to get correct sizes for Exchang
not have these rights, you can still run ExtractWizard, but you will not get accurate ex

To use the API Method for Legato NetWorker 
Install the Legato client software on the computer that will be running ExtractWizard. 

Start ExtractWizard. Click the Start button, and then point to Programs. Point to Ont
PowerControls, and then click ExtractWizard. The first page describes the wizard.  

 

3. (Optional) To change the location of the license file, click About and then click License Info. Under 
License File Name, specify a new location.  

The license file controls which ExtractWizard agents are active. For more information, see “Enabling 
the Licensing Agents” on page 5. 

4. Click Next. 
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The Method of Extraction page of the ExtractWizard offers two methods of extracting backed-up 
Exchange data. For more information on these two methods, see page 12. 

 

5. Select the Advanced Method option. 

6. Select Legato NetWorker from the drop-down menu. 

7. Click Next. 

The Connection Parameters page of the ExtractWizard lets you specify the backup server and client 
computer names. 

 
Connection parameters for Legato NetWorker 
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8. 

• For Backup Server, enter the name of the computer on which the backup server software is 

ation Store. 

, select the 

tractWizard 

Specify the connection parameters: 

installed. 

• For Client, enter the Legato NetWorker client that backed up the Exchange Inform

• For Only catalog Exchange databases that were backed up in this time period
desired time period. 

The Catalog Progress page of the ExtractWizard shows the catalog progress. The Ex
queries the Legato backup server database for Information Store backups.  

 

9. 

tractWizard 

actWizard. 

 

Do one of the following:  

• Click Cancel if you want to stop the catalog process. If you click Cancel, the Ex
catalog will display all files that it found to that point. 

• When the catalog is completed, click Next to proceed to the next page of the Extr
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The Exchange Information Store File Selection page of the ExtractWizard lets you select both the 
private and public Exchange Information Store files that you want to extract from an Exchange 

In the following example, Legato NetWorker contains multiple backup sets and volumes. Each backup 
 l

name and volume name (e.g., exch2ka\Information Store). 

Not

backup.  

set ists the session day and time (e.g., Wed Jan 26 14:36:58 2005). Each volume lists the computer 

e: An asterisk (*) next to a backup indicates that it is an incremental or differential backup. 

 
Extracting a full online disk backup (Legato NetWorker)  

10. On the left side of the window, click the plus sign (+) next to a backup set to view its umes.  

11. Select a volume (select its name, not its check box) to display the Exchange Information Store objects 
 t

12. Select the check boxes next to the .log, .edb, and .stm, files, as well as .pat files, if they exist.  

13. Click

 

 

 

vol

One full online  
backup set 

(Legato 
NetWorker)  

on he right side of the window.  

 Next.  
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The Exchange Information Store Destination Folder page of the ExtractWizard lets you select a 
folder for the extracted files.  

 

Under Destination Folder, specify a location for the extracted files.   

Click Next. The ExtractWizard verifies that you have enough disk space as well as acce
create files and directories, and then begins to extract the Exchange Information Store 
selected. 

14. 

15. ss rights to 
files you have 

f the ExtractWizard shows the progress of 
the ExtractWizard extracting the Exchange Information Store data to the destination folder. This 
The Exchange Information Store Copy Progress page o

process may take some time.  
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16. be 
 files that have completed extraction.  

(Optional) Click Cancel only if you want to stop the process. The file currently being extracted will 
deleted, but you can access any

 
Copy Progress for Legato NetWorker 

The last page of the ExtractWizard displays all of the files that were successfully extracted.  

 

If you are satisfied with the results, click Finish. 

If you extracted multiple data sets, see “Organizing the Extracted Files for PowerCon
112. 

17. 

18. trols” on page 

   43



Chapter 2: Using the ExtractWizard Advanced Method 

Using the Exchange Emulation Method 
The Exchange Emulation method of extracting backed-up Exchange data allows you to run your backup 
soft hange server. 
Extract nge uses.  

Tw
1. e restored. 

2. erform a 
Wizard acts as 

ware and restore to the computer running ExtractWizard, which acts as the alternate Exc
Wizard responds to the backup software by using the same interfaces that Excha

o Basic Steps for Using the Exchange Emulation Method  
Start ExtractWizard on the computer where the Exchange Information Store files will b
Then configure it for the Advanced Method of Exchange Emulation. 

Start your backup restore software on the computer you normally run it on, and then p
redirected online restore to an alternate Exchange server. The computer running Extract
the alternate Exchange server. 

 

• e Information 

 used to initiate the restore. It may be on the same 
computer running ExtractWizard.  

 For Veritas NetBackup, you must run your backup restore software on the computer running 
ExtractWizard. 

Terms 
Restore Target Computer is the computer running ExtractWizard, where the Exchang
Store files will be restored. 

• Backup Restore Software is the backup software

Note:
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Requirements for Using the Exchange Emulation Method  
The Advanced Method for Exchange Emulation has five requirements: 

• Only online Exchange backups are supported. This includes full, copy, incremental, and differential 
backups. 

• The backup client software must be installed on the computer running ExtractWizard. 

• 

e information, see the instructions for each type of backup software 
discussed in this section. 

ExtractWizard cannot be run on an Exchange server. 

• Backup restore .dll files must be in the system path on the computer running ExtractWizard. For 
Exchange 2000/2003, esebcli2.dll is required as well as a registry key pointing to it. For Exchange 5.5, 
edbbcli.dll is required. For mor

• You must have the rights to create and start services on the computer running ExtractWizard.  

Exchange Emulation for Microsoft NT Backup 
In order to run Microsoft NT Backup on the computer running Exchange Emulation, NT Backup must be 
set up to do online Exchange backups. If it is not, follow the instructions in this Microsoft Knowledgebase 
article: 

• XADM: How to Use Microsoft NT Backup from a Non-Exchange 2000 Computer 
http://support.microsoft.com/?kbid=275876 

For information on related topics, refer to these Microsoft knowledge base articles: 

• XADM: Troubleshooting a Remote Online Backup of Exchange 2000 
http://support.microsoft.com/?kbid=275676 

• XADM: Files Needed to Perform Exchange NT Backup on Workstation 
http://support.microsoft.com/?kbid=181445 
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Exchange Emulation for NT Backup: Exchange 2000/2003 on Windows 2000/XP/2003  
ollowing1. On the computer that will be running ExtractWizard, do one of the f :  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winnt\system32 or windows\system
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin

32.  
 directory.) 

ontrolSet\Control\BackupRestore\DLLPaths 
 

Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentC
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 

he Restore Target Computer. 

3. On the first page of the ExtractWizard, click Next.  

4. tractWizard, select Advanced Method and NT Backup. 
Then click Next. 

Example of Setting the Registry Key 

2. Start ExtractWizard. The computer running ExtractWizard is known as t

On the Method of Extraction page of the Ex
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Connection Parameters page of the ExtractWizard appears. The 

 

5. Select the Exchange Server 2000 or Exchange Server 2003 option. 

6. In the Storage Groups box, enter the name of the storage group you will be extracting. The storage 
group name is case sensitive and must match exactly the name that appears in the Exchange System 
Manager. You can enter multiple storage groups, separated by semicolons (;).  

7. Click Next.  

8. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 
valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 
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9. m “Initializing” to “Emulating 
Exchange Server,” you are ready to start NT Backup. Do not click the Stop button until you reach the 
When the ExtractWizard Exchange Emulation page changes fro

end of these instructions.  

Tip: You can copy 
the “Restore to” 
and “Log file 
path” information 
on this page and 
paste it into NT 
Backup when 
prompted later in 
this section. 

 

 

11. Do on e following: 

10. Start NT Backup (Backup Utility in Windows XP and 2003) on the computer you normally run your 
restores on. This can be the same computer as the one running ExtractWizard. 

e of th

• If NT Backup is on a different computer than ExtractWizard, proceed to step 12. 

• If NT Backup is on the same computer as ExtractWizard, skip steps 12-15 and proceed to  
step 16. 
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12. 

13. 

14. puter 
 verify that you 

zard. Click OK. 

15.  the Backup tree 
up is not able to 

is article from 
 of Exchange 

In NT Backup, click the Backup tab.  

On the Tools menu, click Remote Store. 

In the Remote Store dialog box, enter the name of the Restore Target Computer (i.e., the com
running ExtractWizard). The name must be in all capital letters. See previous step 9 to
are using the “Restore to” value from the Exchange Emulation page of the ExtractWi

If you receive an error stating that the Microsoft Exchange Server does not appear in
(i.e., it does not appear in the left pane in the Backup tab), this means that NT Back
verify the ExtractWizard emulation. Therefore, you must follow the steps outlined in th
the Microsoft Knowledge Base: “XADM: Troubleshooting a Remote Online Backup
2000”: http://support.microsoft.com/?kbid=275676  

When NT Backup has finished verifying the computer, the Restore Target computer a
Microsoft Exchange Server node. 

In NT Backup, click the Restore tab (the Restore and Manage Media tab in Window

In the tree view, select your Exchange backup from the list of media.   

ppears under the 

16. s 2003). 

17. 

 

19. er the name of the Restore Target Computer (i.e., the computer running 
 th

the “Restore to” value from the Exchange Emulation page of the ExtractWizard.  

20. In the Temporary location for log and patch files box, enter the log file path. See pr
verify that you are using the “Log file path” value from the Exchange Emulation page 
ExtractWizard. 

21.  boxes at the bottom of the Restoring Database Resto

22. Click OK. NT Backup will start to restore Exchange files to the ExtractWizard. The R ss 
dialog box appears. 

23. When NT Backup has finished, click Close and close NT Backup. 

24. In ExtractWizard, click Stop and then click Finish. 

18. Click the Start Restore button. The Restoring Database Store dialog box appears. 

In the Restore To box, ent
ExtractWizard). The name must be in all capital letters. See previous step 9 to verify at you are using 

evious step 9 to 
of the 

re dialog box. 

estore Progre

Do not select either of the check
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Exchange Emulation for NT Backup: Exchange 5.5 on Windows 2000/XP/2003  
1. On the computer that will be running ExtractWizard, make sure edbbcli.dll is in the system path.  

bbcli.dll to winnt\system32 or windows\system32.  
The edbbcli.dll file can be found on the Exchange Server in the Exchange Server\bin directory. 

2. 

3. On the first page of the ExtractWizard, click Next.  

4. . 

The easiest way to ensure this is to copy ed

Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

On the Method of Extraction page of the ExtractWizard, select Advanced Method and NT Backup
Then click Next. 

 

5. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option 
and click Next.  
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6. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
is a 

omplete 
location for the extracted files. This location must be a local drive and of the form x:\Path where x 
valid drive letter that has an administrative share associated with it such as x$, and Path is the c
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

7.  to “Emulating 
ntil you reach the 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start NT Backup. Do not click the Stop button u
end of these instructions. 

 

Tip: You can copy 
the “Restore to” 

 on 
 

paste it into NT 
Backup when 
prompted later in 
this section. 

information
this page and
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8. Start NT Backup (Backup Utility in Windows XP and 2003) on the computer you normally run y
restores on. This can be the same computer as the one running ExtractWizard. 

In NT Backup, click the Restore tab (the Restore and Manage Media tab in Wind

our 

9. ows 2003).  

10. u to restore 

11. rs. 

12. 

13. er running 
hat you are using 

14. 

15. 

16. 

In the tree view, select your Exchange backup from the list of media. NT Backup allows yo
only one Exchange Information Store at a time. 

Note: You cannot restore the Directory. 

Click the Start Restore button. The Restoring Microsoft Exchange dialog box appea

Select the Erase all existing data check box. 

In the Restore To box, enter the name of the Restore Target Computer (i.e., the comput
ExtractWizard). The name must be in all capital letters. See previous step 7 to verify t
the “Restore to” value from the Exchange Emulation page of the ExtractWizard. 

Click OK. NT Backup will start to restore Exchange files to the ExtractWizard. 

When NT Backup has finished, click Close and close NT Backup. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for NT Backup: Exchange 5.5 on Windows NT 4  
On the computer that will be running ExtractWizard, make sure edbbcli.dll is in1.  the system path.  
The easiest way to ensure this is to copy edbbcli.dll to winnt\system32 or windows\system32.  

3. On the first page of the ExtractWizard, click Next.  

4. On the Method of Extraction page of the ExtractWizard, select Advanced Method and NT Backup. 

The edbbcli.dll file can be found on the Exchange Server in the Exchange Server\bin directory. 

2. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

Then click Next. 

 

5. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option 
and click Next.  
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6. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
is a 

omplete 
location for the extracted files. This location must be a local drive and of the form x:\Path where x 
valid drive letter that has an administrative share associated with it such as x$, and Path is the c
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

7.  to “Emulating 
ntil you reach the 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start NT Backup. Do not click the Stop button u
end of these instructions. 

 

Tip: You can copy 
the “Restore to” 

 on 
d 

paste it into NT 
Backup when 
prompted later in 
this section. 

information
this page an
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8. Start Microsoft NT Backup on the computer you normally run your restores on. This can be the s
computer as the one running ExtractWizard. 

In the Tapes window, select the Exchange backup you want to restore. NT Backup allo

ame 

9. ws you to 
restore only one Exchange Information Store at a time. 

10. 

11. ., the computer 
 verify that you 

zard. 

12. 

13. 

14. 

15. 

 

 

Note: You cannot restore the Directory. 

Click the Restore button. The Restoring Microsoft Exchange dialog box appears. 

In the Destination Server box, enter the name of the Restore Target Computer (i.e
running ExtractWizard). The name must be in all capital letters. See previous step 7 to
are using the “Restore to” value from the Exchange Emulation page of the ExtractWi

Select the Erase all existing data check box. 

Click OK. NT Backup will start to restore Exchange files to the ExtractWizard. 

When NT Backup has finished, click Close and close NT Backup. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for HP OpenView Storage Data Protector 

Exchange Emulation for HP OpenView Storage Data Protector and Exchange 2000/2003  
1. Install HP client software on the computer that will be running ExtractWizard. When choosing 

components for this client, make sure to include the MS Exchange 2000 Integration component. 

Note: If the computer running ExtractWizard already has the HP client software installed, make sure 
the MS Exchange 2000 Integration component has been included in the installation. 

2. On the computer that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winnt\system32 or windows\system32.  
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin directory.) 
Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll 

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 
Example of Setting the Registry Key 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  
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5. On the Method of Extraction page of the ExtractWizard, select Advanced Method and HP 
OpenView Storage Data Protector. Then click Next. 

 

6. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 2000 or 
Exchange Server 2003 option, and then click Next. 
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7. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 

ociated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 
valid drive letter that has an administrative share ass

 

When the ExtractWizard Exchange Emulation page changes from “Initializing”8.  to “Emulating 
Exchange Server,” you are ready to start HP OpenView Storage Data Protector. Do not click the Stop 
button until you reach the end of these instructions. 

 

Tip: You can refer 
to the “Restore 
to” and “Log file 
path” information 
on this page when 
verifying it in HP 
OpenView Storage 
Data Protector 
later in this 
section. 
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9. Start HP OpenView Storage Data Protector on the computer you normally run your restores on. T
can be the same computer as the one running ExtractWizard.   

Select Restore from the drop-down list at the top left of the window.  

his 

10. 

11. riate Exchange 

12. o restore. 

13. 

14. 

15. ous step 8 to 
 the 

16. 8 to verify that 
actWizard. 

17. 

 a message 

 

19. s available. 

20. 

21. 

n

22. ata Protector says it has finished, close the program. 

23. In ExtractWizard, click Stop and then click Finish. 

 

In the left pane, expand the MS Exchange 2000 Server tree node and select the approp
Server. 

In the right pane, click the Source tab and then select the Exchange backup you want t

In the right pane, click the Options tab. 

Select the Restore to another client check box.  

Select the name of the Restore Target Computer from the drop-down menu. See previ
verify that you are using the “Restore to” value from the Exchange Emulation page of
ExtractWizard. 

In the Directory for temporary log files box, enter the log file path. See previous step 
you are using the “Log file path” value from the Exchange Emulation page of the Extr

Do not select the Last resort set (start recovery) check box. 

Note: If this check box is selected, HP OpenView Storage Data Protector will display
stating the restore failed. Click OK. The files will still be extracted and usable. 

18. Click the Devices tab, and verify your devices are properly configured  

Click the Media tab, and verify the required media i

Click the Restore button. The Start Restore Session dialog box appears. 

Do one of the following: 

• Click Next to specify options on Report level and Network load, and then click Fi ish. 

• Click Finish. 

When HP OpenView Storage D
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Exchange Emulation for HP OpenView Storage Data Protector and Exchange 5.5  
Install HP client software on the computer that will be running Ex1. tractWizard. When choosing 
components for this client, make sure to include the MS Exchange 5.x Integration component.  

Note: If the computer running ExtractWizard already has the HP client software installed, make sure 

2. On the computer running ExtractWizard, make sure edbbcli.dll is in the system path. The easiest way 
can 

be found on the Exchange Server in the Exchange Server\bin directory. 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  

5. P 
age Data Protector. Then click Next. 

the MS Exchange 5.x Integration component has been included in the installation. 

to ensure this is to copy edbbcli.dll to winnt\system32 or windows\system32. The edbbcli.dll file 

On the Method of Extraction page of the ExtractWizard, select Advanced Method and H
OpenView Stor
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6. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option, 
and then click Next. 

 

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be a local drive and of the form x:\Path 
valid drive letter that has an administrative share associated with it such as x$, and Pat
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

7. zard, specify a 
where x is a 

h is the complete 
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8. When the ExtractWizard Exchange Emulation page changes from “Initializing” to “Emulating 
Exchange Server,” you are ready to start HP OpenView Storage Data Protector. Do not click the Stop 
button until you reach the end of these instructions. 

 

Tip: You can refer 
to the “Restore 
to” information on 
this page when 
verifying it in HP 
OpenView Storage 
Data Protector 
later in this 
section. 

 

9. Start HP OpenView Storage Data Protector on the computer you normally run your restores on. This 
can be the same computer as the one running ExtractWizard.   

Select Restore from the drop-down list at the top left of the window.  

 

10. 

11. xchange 

12. 

13. 

14. 

15. ous step 8 to 
 the 

16. after restore 

lay a message 
stating the restore failed. Click OK. The files will still be extracted and usable. 

In the left pane, expand the MS Exchange 5.x Server folder and select the appropriate E
Server. 

In the right pane, select the Exchange backup you would like to restore.  

Note: You cannot restore the DS object. 

In the right pane, click the Options tab. 

Select the Restore to another client checkbox.  

Select the name of the Restore Target Computer from the drop-down menu. See previ
verify that you are using the “Restore to” value from the Exchange Emulation page of
ExtractWizard. 

Do not select either the Stop services before restore check box or the Start services 
check box.  

Note: If these check boxes are selected, HP OpenView Storage Data Protector will disp
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17. Under Restore actions, select the action you want to perform:  

• Restore both databases 

 

18. 

19. 

20. 

21. 

Finish. 

22. 

23. 

• Restore private database only 

• Restore public database only 

Click the Devices tab, and verify your devices are properly configured  

Click the Media tab, and verify the required media is available. 

Click the Restore button. The Start Restore Session dialog box appears. 

Do one of the following: 

• Click Next to specify options on Report level and Network load, and then click 

• Click Finish. 

When HP OpenView Storage Data Protector says it has finished, close the program. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for Veritas Backup Exec 8.6 and 9.1/10.0 

Exchange Emulation for Veritas Backup Exec 9.1/10.0 and Exchange 2000/2003  
1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer that will 

be running ExtractWizard.  

2. On the computer that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winnt\system32 or windows\system32.  
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin directory.) 
Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll 

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 
Example of Setting the Registry Key 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  
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5. On the Method of Extraction page of the ExtractWizard, select Advanced M
Backup Exec. Then click Next. 

ethod and Veritas 

 

Connection Parameters page of the ExtractWizard appears. The 

 

6. Select the Exchange Server 2000 or Exchange Server 2003 option. 

7. In the Storage Groups box, enter the name of the storage group you will be extracting. The storage 
group name is case sensitive and must match exactly the name that appears in the Exchange System 
Manager. You can enter multiple storage groups, separated by semicolons (;). Click Next.  
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8. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 
valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

9.  to “Emulating 
til you reach the 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start Backup Exec. Do not click the Stop button un
end of these instructions. 

 

Start Veritas Backup Exec 9.1 on the computer you normally run your restores on. This can10.  be the 
same computer as the one running ExtractWizard.  

11. Click the Restore button. The Restore Job Properties window appears.  

Tip: You can copy 
the “Restore to” 
and “Log file 
path” information 
on this page and 
paste it into 
Backup Exec when 
prompted later in 
this section. 
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12. In the Properties pane, select Selections under the Source heading. 

In the All Resources tree, select the Exchange backup you want to restore. 

 

13. 

14. In the Properties pane, select Exchange Redirection under the Destination heading. 

15. 

16. e computer 
o” value from 

17. select must have 

18. 

19. x. 

il. 

20. ious step 9 to 
 of the 

21. Clear the Commit after restore completes check box.  

utomatically delete the restored files after completing the restore. 

22. fe
Organization names. You can safely click Yes. ExtractWizard and PowerControls do no
the Site and Organization names. Backup Exec will start to restore Exchange files to the  

23. When Backup Exec has finished, click OK and close Backup Exec. 

24. d then click Finish. 

Select the Redirect Exchange sets check box. 

In the Restore to server box, enter the name of the Restore Target Computer (i.e., th
running ExtractWizard). See previous step 9 to verify that you are using the “Restore t
the Exchange Emulation page of the ExtractWizard. 

In the Server logon account, change the logon account if necessary. The account you 
backup operator rights to the Restore Target Computer. 

In the Properties pane, select Exchange under the Settings heading. 

In the Exchange 2000 and Exchange 2003 area, clear the No Loss Restore check bo

IMPORTANT NOTE: If the No Loss Restore check box is selected, the restore will fa

In the Temporary location for log and path files box, enter the log file path. See prev
verify that you are using the “Log file path” value from the Exchange Emulation page
ExtractWizard. 

CAUTION: Make sure to clear the Commit after restore completes check box. If this check box 
remains selected, Backup Exec will a

Click Run Now. Backup Exec will display a warning about restoring a server with dif rent Site and 
t depend on 
ExtractWizard

In ExtractWizard, click Stop an
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Exchange Emulation for Veritas Backup Exec 9.1/10.0 and Exchange 5.5  
1. Install “Backup Exec Remote Agent for Windows Servers” client software on the computer that will 

be running ExtractWizard.  

2. On the computer running ExtractWizard, make sure edbbcli.dll is in the system path. The easiest way 
to ensure this is to copy edbbcli.dll to winnt\system32 or windows\system32. The edbbcli.dll file can 
be found on the Exchange Server in the Exchange Server\bin directory. 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  

5. On the Method of Extraction page of the ExtractWizard, select Advanced Method and Veritas 
Backup Exec. Then click Next. 
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6. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option, 
and click Next. 

 

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be a local drive of the form x:\Path whe
valid drive letter that has an administrative share associated with it such as x$, and Pat
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

7. zard, specify a 
re x is a 

h is the complete 
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8. When the ExtractWizard Exchange Emulation page changes from “Initializing” to “Emulating 
Exchange Server,” you are ready to start Backup Exec. Do not click the Stop button until you reach the 
end of these instructions. 

Tip: You can copy 
the “Restore to” 
information on 
this page and 
paste it into 
Backup Exec when 
prompted later in 
this section. 

 

9. 

10. Click the Restore button at the top left of the Backup Exec window. The Restore Job Properties 

11. 

12. 

13. 

14. 

15. e computer 
o” value from 

16. select must have 

17. 

18. In the Exchange v5.5 area, clear the No Loss Restore check box. 

IMPORTANT NOTE: If the No Loss Restore check box is selected, the restore will fail. 

Start Veritas Backup Exec 9.1 on the computer you normally run your restores on. This can be the 
same computer as the one running ExtractWizard. 

window appears.  

In the Properties pane, select Selections under the Source heading. 

In the All Resources tree, select the Exchange backup you want to restore.  

Note: You cannot restore the Microsoft Exchange Directory. 

In the Properties pane, select Exchange Redirection under the Destination heading. 

Select the Redirect Exchange sets check box. 

In the Restore to server box, enter the name of the Restore Target Computer (i.e., th
running ExtractWizard). See previous step 8 to verify that you are using the “Restore t
the Exchange Emulation page of the ExtractWizard.  

In the Server logon account, change the logon account if necessary. The account you 
backup operator rights to the Restore Target Computer. 

In the Properties pane, select Exchange under the Settings heading. 
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19. Select one or both of the following check boxes: Select the Restore public folder if you would lik
restore the pub.edb. Select the Restore private mailboxes if you would like to restore the priv.edb.  

 e to 

20. Click Run Now. Backup Exec will display a warning about restoring a server with differen
 no

the Site and Organization names. Backup Exec will start to restore Exchange files to the 
ExtractWizard. 

21. When Backup Exec has finished, click OK and close Backup Exec. 

22. d then click Finish. 

 

t Site and 
t depend on Organization names. You can safely click Yes. ExtractWizard and PowerControls do

In ExtractWizard, click Stop an
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Exchange Emulation for Veritas Backup Exec 8.6 and Exchange 2000/2003  
Install “Backup Exec Remote Agent for Windows Servers” client software on the computer that will 1. 
be running ExtractWizard. 

2. On the computer that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winn
(The esebcli2.dll file is located on the Exchange

t\system32 or windows\system32.  
 Server in the Exchange Server\bin directory.) 

Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll 

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 
Example of Setting the Registry Key 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  
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5. On the Method of Extraction page of the ExtractWizard, select Advanced Method and Veritas 
Backup Exec. Then click Next. 

 

Connection Parameters page of the ExtractWizard appears. The 

 

6. Select the Exchange Server 2000 or Exchange Server 2003 option. 

7. In the Storage Groups box, enter the name of the storage group you will be extracting, exactly as it 
appears in the Exchange System Manager. Backup Exec will check this name, which is case sensitive, 
and it must match exactly. You can enter multiple storage groups, separated by semicolons (;).  
Click Next.  
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8. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 
valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

9.  to “Emulating 
til you reach the 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start Backup Exec. Do not click the Stop button un
end of these instructions. 

 

Start Veritas Backup Exec 8.6 on the computer you normally run your restores on. This can be th
same comput

10. e 
er as the one running ExtractWizard. 

Tip: You can copy 
the “Restore to” 
and “Log file 
path” information 
on this page and 
paste it into 
Backup Exec when 
prompted later in 
this section. 
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11. On the toolbar at the top of the Backup Exec window, click the Restore button. The Restore Job
Properties dialog box appears. 

In the Restore Job Properties dialog box, click the Selections tab.  

  

12. 

13. 

14. 

15. 

16. vious step 9 to 
 the 

17. 

18. 

il. 

19. ious step 9 to 
 of the 

20. Clear the Commit after restore completes check box.  

utomatically delete the restored files after completing the restore. 

21. fe
Organization names. You can safely click Yes. ExtractWizard and PowerControls do no
the Site and Organization names. Backup Exec will start to restore Exchange files to the 
ExtractWizard. 

22. When Backup Exec has finished, click OK and close Backup Exec. 

23. d then click Finish. 

 

 

In the All Volumes tree, select the Exchange backup you want to restore. 

Click the Redirection tab. 

Select the Redirect Exchange sets check box. 

In the Restore to server box, enter the name of the Restore Target Computer. See pre
verify that you are using the “Restore to” value from the Exchange Emulation page of
ExtractWizard. 

Select the Exchange tab. 

In the Exchange 2000 area, clear the No Loss Restore check box. 

IMPORTANT NOTE: If the No Loss Restore check box is selected, the restore will fa

In the Temporary location for log and path files box, enter the log file path. See prev
verify that you are using the “Log file path” value from the Exchange Emulation page
ExtractWizard. 

CAUTION: Make sure to clear the Commit after restore completes check box. If this check box 
remains selected, Backup Exec will a

Click Run Now. Backup Exec will display a warning about restoring a server with dif rent Site and 
t depend on 

In ExtractWizard, click Stop an
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Exchange Emulation for Veritas Backup Exec 8.6 and Exchange 5.5  
Install “Backup Exec Remote Ag1. ent for Windows Servers” client software on the computer that will 
be running ExtractWizard.  

2. On the computer running ExtractWizard, make sure edbbcli.dll is in the system path. The easiest way 
bcli.dll file can be found on 

the Exchange Server in the Exchange Server\bin directory. 

3. Start ExtractWizard. The computer running ExtractWizard is known as the Restore Target Computer. 

4. On the first page of the ExtractWizard, click Next.  

5. eritas 
hen click Next. 

to ensure this is to copy to winnt\system32 or windows\system32. The edb

On the Method of Extraction page of the ExtractWizard, select Advanced Method and V
Backup Exec. T
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6. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option, 
and click Next. 

 

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be a local drive of the form x:\Path whe
valid drive letter that has an administrative share associated with it such as x$, and Pat
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

7. zard, specify a 
re x is a 

h is the complete 
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8. When the ExtractWizard Exchange Emulation page changes from “Initializing” to “Emulating 
Exchange Server,” you are ready to start Backup Exec. Do not click the Stop button until you reach the 
end of these instructions. 

Tip: You can copy 
the “Restore to” 
information on 
this page and 
paste it into 
Backup Exec when 
prompted later in 
this section. 

 

Start Veritas Backup Exec 8.6 on the computer you normally run your restores on. This can be the 
same computer as the one running ExtractWizard. 

9. 

10. Click the Restore button at the top left of the Backup Exec window. The Restore Job Properties 

11. 

12. 

13. 

14. 

15. vious step 8 to 
 the 

16. 

17. 

IMPORTANT NOTE: If the No Loss Restore check box is selected, the restore will fail. 

18. Select one or both of the following check boxes: Select the Restore public folder if you would like to 
restore the pub.edb. Select the Restore private mailboxes if you would like to restore the priv.edb.  

dialog box appears. 

In the Restore Job Properties dialog box, click the Selections tab.  

In the All Volumes tree, select the Exchange backup you want to restore. 

Note: You cannot restore the Microsoft Exchange Directory. 

Click the Redirection tab. 

Select the Redirect Exchange sets check box. 

In the Restore to server box, enter the name of the Restore Target Computer. See pre
verify that you are using the “Restore to” value from the Exchange Emulation page of
ExtractWizard. 

Select the Exchange tab. 

In the Exchange v5.5 area, clear the No Loss Restore check box. 
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19. Click Run Now. Backup Exec will display a warning about restoring a server with different Site an
Organization names. You can safely click Yes. ExtractWizard and PowerControls do not depend on 
the Site and Organization 

 d 

names. Backup Exec will start to restore Exchange files to the 
ExtractWizard. 

20. 

21. 

When Backup Exec has finished, click OK and close Backup Exec. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for CA BrightStor ARCserve 

hange Emulation for CA BrightStor ARCserve and Exchange 2000/2003  
On the computer

Exc
1.  that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system path to include 

 Option 2

the Exchsrvr\bin\ directory. 

• : Copy esebcli2.dll to the system path: winnt\system32 or windows\system32.  
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin directory.) 
Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll 

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 
Example of Setting the Registry Key 

2. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

3. On the first page of the ExtractWizard, click Next.  
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4. On the Method of Extraction page of the ExtractWizard, select Ad
BrightStor ARCserve. Then click Next. 

vanced Method and CA 

 

Connection Parameters page of the ExtractWizard appears. The 

 

5. Select the Exchange Server 2000 or Exchange Server 2003 option. 

6. In the Storage Groups box, enter the name of the storage group you will be extracting. The storage 
group name is case sensitive and must match exactly as it appears in the Exchange System Manager. 
You can enter multiple storage groups, separated by semicolons (;).  

7. Click Next.  
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8. If ExtractWizard displays a warning about the ARCserve Exchange client not being properly 
configured for emulating Exchange 2000/2003, click OK to continue. You can configure the 
ARCserve Exchange client when you get to step 12 later in this section. 

9. zard, specify a 
re x is a 

h is the complete 

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be a local drive of the form x:\Path whe
valid drive letter that has an administrative share associated with it such as x$, and Pat
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start BrightStor ARCserve. Do not click the Stop
reach the end of these instructions. 

10.  to “Emulating 
 button until you 

 

Tip: You can copy 
the “Restore to” 
and “Log file 
path” information 
on this page and 
paste it into 
BrightStor 
ARCserve when 
prompted later in 
this section. 
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11. Make sure “BrightStor ARCserve Client Agent for Windows” software and “Backup Agent fo
Microsoft Exchange” software are installed on the computer running ExtractWizard.  

 r 

12. If you have already installed the Backup Agent for Exchange 5.5 and you wish to emulate Exchange 
2000/2003, you must do one of the following: 

• Option 1: Reinstall the Backup Agent for Microsoft Exchange with ExtractWizard, running the 
correct emulation type. 

• Option 2: Manually edit the registry setting for the ARCserve Exchange client
following key exists: 
HKEY_LOCAL_MACHINE\SOFTWARE\ComputerAssociates\BrightStor ARCs
Backup\DSAgent\CurrentVersion\agent\dbaexch. In this key, make sure the 
value “isExch2000” exists with a value of “1”. 

Start BrightStor ARCserve on the computer you normally run your restores on. Th
computer as the one running ExtractWizard. The BrightStor ARCserve window app

On the Quick Start menu, click Restore. A Server tree appears in the Source tab. 

In the Source tab, select the Exchange backup you want to restore. 

Right-click the storage group you want to restore and click Backup Agent Option. T
Agent Restore Options dialog box appears. 

In the Temporary location for log and path files box, enter the log file path. See prev
verify that you are using the “Log file path” value from the Exchange Emulation page
ExtractWizard. 

. Make sure the 

erve 
REG_DWORD 

13. is can be the same 
ears. 

14. 

15. 

16. he Backup 

17. ious step 10 to 
 of the 

19. 

20. 

w
NT/2000/XP/2003 Systems tree. 

21. In the Network tree, expand the Microsoft Windows Network node, and locate the Re
Computer. If the Restore Target Computer does not appear, do one or both of the follow

• p that the Restore Target Computer belongs to does not a
Microsoft Windows Network node, right-click the Microsoft Windows Network no
Add Machine/Object. In the Add Object dialog box, enter the domain or workgroup and click 
Add. 

• If the Restore Target Computer does not appear in the domain or workgroup it belongs to, right-
click the domain or workgroup node, and click Add Machine/Object. In the Add Object dialog 
box, enter the name of the Restore Target Computer and click Add. See previous step 10 to verify 
that you are using the “Restore to” value from the Exchange Emulation page of the ExtractWizard. 

22. Expand the Restore Target Computer node and select the Microsoft Information Store node.  

Note: If the Microsoft Information Store node does not appear under the Restore Target Computer, 
select the Restore Target Computer node so that its name appears in the Address box above the 

18. Click OK to close the Backup Agent Restore Options dialog box. 

Click the Destination Tab. 

Clear the Restore files to their original location check box. 

Important Note: For the following two steps, use the Network tree. Do not use the Windo s 

store Target 
ing: 

ppear in the 
de and click 

 If the domain or workgrou
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Destination tree. Then append \dbaexchis to the Restore Target Computer name. This signals 
ARCserve you are restoring an Information Store.  

23. On the toolbar, click the Start button.  

24. If the Remote Agent Security is not properly configured, the Security dialog box appears. Make sure 
u

back  Restore Target Computer. Click OK. 

e

25. Ver

26. Clic

 

yo r Server logon account (User Name and Password) is correct. The account you use must have 
up operator rights to the

Th  Session User Name and Password dialog box appears. 

ify the session information is correct. 

k OK. The Submit Job dialog box appears. 

27. In the Description box, enter a description if desired, and click OK. ARCserve will start to restore 
Exchange files to the ExtractWizard. 

28. When ARCserve has finished, click OK and close ARCserve. 

29. In ExtractWizard, click Stop and then click Finish. 
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Exc
1. , make sure edbbcli.dll is in the system path. The 

easiest way to ensure this is to copy edbbcli.dll to winnt\system32 or windows\system32. The 
ange Server in the Exchange Server\bin directory. 

3. 

4. ct Advanced Method and CA 
BrightStor ARCserve. Then click Next. 

hange Emulation for CA BrightStor ARCserve and Exchange 5.5  
On the computer that will be running ExtractWizard

edbbcli.dll file can be found on the Exch

2. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

On the first page of the ExtractWizard, click Next.  

On the Method of Extraction page of the ExtractWizard, sele

 

5. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option. 
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6. In the Site and Org boxes, enter the Site and Org for the Exchange Information Store files you are 

7. Click Next.  

8. If ExtractWizard displays a warning about the ARCserve Exchange client not being properly 
 continue. You can configure the ARCserve 

Exchange client when you get to step 12 later in this section. 

9. tination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be of the form x:\Path where x is a valid drive letter 

lete path to a folder 

preparing to restore. The Site and Org names are case sensitive and must match exactly as they appear 
in the Exchange System Manager.  

configured for emulating Exchange 5.5, click OK to

On the Exchange Information Store Des

that has an administrative share associated with it such as x$, and Path is the comp
(if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

 86 



Ontrack® PowerControls™ 4.0 User Guide 

10. When the ExtractWizard Exchange Emulation page changes from “Initializing” to “Emulating 
Exchange Server,” you are ready to start BrightStor ARCserve. Do not click the Stop button until you 
reach the end of these instructions. 

 

 

Make sure “BrightStor ARCserve Client Agent for Windows” software and “Backup 
Microsoft Exchange” software are installed on the computer running ExtractWizard.  

If you have already installed the Backup Agent for Exchange 2000/2003 and you 
Exchange 5.5, you must do one of the following

11. Agent for 

12. wish to emulate 
: 

• Option 1: Reinstall the Backup Agent for Microsoft Exchange with ExtractWizard
correct emulation type. 

• Option 2

, running the 

: Manually edit the registry setting for the ARCserve Exchange client. Mak
following key exists: 

e sure the 

HKEY_LOCAL_MACHINE\SOFTWARE\ComputerAssociates\BrightStor ARCserve 
Backup\DSAgent\CurrentVersion\agent\dbaexch. In this key, make sure the REG_DWORD 
value “isExch2000” does not exist. 

Important Note: If REG_DWORD value “isExch2000” exists, delete it. 

13. Start BrightStor ARCserve on the computer you normally run your restores on. This can be the same 
computer as the one running ExtractWizard. The BrightStor ARCserve window appears. 

14. On the Quick Start menu, click Restore. A Server tree appears in the Source tab. 

15. Select the Exchange backup you want to restore. 

Note: You cannot restore the Directory. 

16. Click the Destination tab. 

17. Clear the Restore files to their original location check box. 

Tip: You can copy 
the “Restore to” 

og file 
rmation 

on this page and 
paste it into 

r 

n 
this section. 

and “L
path” info

BrightSto
ARCserve when 
prompted later i
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Important Note: For the following two steps, use the Network tree. Do not use the Windows 
2000/XP/2003 Systems tree. NT/

18. In the Network tree, expand the Microsoft Windows Network node, and locate the Restore Target 
ow

• If the domain or workgroup that the Restore Target Computer belongs to does not 
Microsoft Windows Network node, right-click the Microsoft Windows Network n
Add Machine/Object. In the Add Object dialog box, enter the domain or workgr
Add. 

uter does not appear in the domain or workgroup it bel
click the domain or workgroup node, and click Add Machine/Object. In the Add
box, enter the name of the Restore Target Computer and click Add. See previous s fy 
that you are using the “Restore to” value from the Exchange Emulation page of the ExtractWizard. 

19. Expand the Restore Target Computer node and select the Microsoft Exchange Server node.  

Note: If the Microsoft Exchange Server node does not appear under the Restore Target Computer, 
select the Restore Target Computer node so that its name appears in the Address box above the 
Destination tree. Then append \dbaexch to the Restore Target Computer name. This signals ARCserve 
you are restoring an Information Store.  

20. On the toolbar, click the Start button.   

 sure 
must have 

OK

x appears. 

22. 

23. Click OK. The Submit Job dialog box appears. 

24. In th e 
Exc

25. Whe nd close ARCserve. 

26. In E

Computer. If the Restore Target Computer does not appear, do one or both of the foll ing: 

appear in the 
ode and click 
oup and click 

ongs to, right-
 Object dialog 
tep 10 to veri

• If the Restore Target Comp

21. If the Remote Agent Security is not properly configured, the Security dialog box appears. Make
your Server logon account (User Name and Password) is correct. The account you use 
backup operator rights to the Restore Target Computer. Click . 

The Session User Name and Password dialog bo

Verify the session information is correct. 

e Description box, enter a description if desired, and click OK. ARCserve will start to restor
hange files to the ExtractWizard. 

n ARCserve has finished, click OK a

xtractWizard, click Stop and then click Finish. 
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Exchange Emulation for Veritas NetBackup 

Exchange n for Veritas NetB 003  

Note mputer 
running ExtractWizard. 

1. Inst  

2. Allo omputer running ExtractWizard to restore backups created by the Exchange server client. 
Follow the instructions for allowing redirected restores in the NetBackup Administrators Guide. 

3. On t

 Emulatio ackup and Exchange 2000/2
 

: For NetBackup 4.5, you must install the NetBackup client and the Exchange agent on the co

all NetBackup client software for Windows on the computer that will be running ExtractWizard.  

w the c

he computer that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winnt\system32 or windows\system32.  
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin directory.) 
Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path\Esebcli2.dll 

t32.exe to create a REG_EXPAND_SZ value. Note for Windows 2000: Use reged

 

izard is the Restore Target Computer. 

. On the first page of the ExtractWizard, click Next.  

Example of Setting the Registry Key 

4. Start ExtractWizard. The computer running ExtractW

5

   89



Chapter 2: Using the ExtractWizard Advanced Method 

6. On the Method of Extraction page of the ExtractWizard, 
NetBackup. Then click Next. 

select Advanced Method and Veritas 

 

The Connection Parameters page of the ExtractWizard appears. 

 

7. Select the Exchange Server 2000 or Exchange Server 2003 option. 

8. In the Storage Groups box, enter the name of the storage group you will be extracting. The storage 
group name is case sensitive and must match exactly the name that appears in the Exchange System 
Manager. You can enter multiple storage groups, separated by semicolons (;).  

9. Click Next.  
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10. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. 

 
This location must be a local drive of the form x:\Path where x is a 

valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

11.  to “Emulating 
 reach the 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start NetBackup. Do not click the Stop button until you
end of these instructions. 

Tip: You can copy 
the “Log file 
path” information 
on this page and 
paste it into 
NetBackup when 
prompted later in 
this section. 

 

Start the NetBackup client on the computer running ExtractWizard. 12. 

 enu, click Specify NetBackup Machines and Policy Type. (For NetBackup 4.5, click 
Specify NetBackup Machines.) 

13. On the File m
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14. In the Specify NetBackup Machines and Policy Type dialog box, click the Client/Policy Type

Under Client List, select the Exchange client you wish to restore from and make it the current client. 
Click OK. 

 tab.  

15. 

16. up you wish to 

17. 

18. heck box. 

 will automatically 

19. us step 11 to 
 of the 

20. 

21. 

22. 

On the toolbar, click the Select for Restore button, and then select the Exchange back
restore.  

On the Actions menu, click Start Restore of Marked Files.  

In the Restore Marked Files dialog box, clear the Commit after restore completes c

CAUTION: If the Commit after restore completes check box is selected, NetBackup
delete the restored files after completing the restore. 

In the Temporary location for log and patch files box, enter the log file path. See previo
verify that you are using the “Log file path” value from the Exchange Emulation page
ExtractWizard. 

Click the Start Restore button. 

When NetBackup has finished, click OK and close NetBackup. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for Veritas NetBackup and Exchange 5.5  
 

runn izard. 

2. Allow the computer running ExtractWizard to restore backups created by the Exchange server client. 
p Administrators Guide. 

ay 
is to copy edbbcli.dll to winnt\system32 or windows\system32. The edbbcli.dll file can be found on the 

4. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

5. 

6. On the Method of Extraction page of the ExtractWizard, select Advanced Method and Veritas 

Note: For NetBackup 4.5, you must install the NetBackup client and the Exchange agent on the computer 
ing ExtractW

1. Install NetBackup client software for Windows on the computer that will be running ExtractWizard.   

Follow the instructions for allowing redirected restores in the NetBacku

3. On the computer running ExtractWizard, make sure edbbcli.dll is in the system path. The easiest w

Exchange Server in the Exchange Server\bin directory. 

On the first page of the ExtractWizard, click Next.  

NetBackup. Then click Next. 
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7. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option 
and click Next.  

 

8. zard, specify a 
 x:\Path where x is a 

 Path is the complete 
. 

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be a local drive of the form
valid drive letter that has an administrative share associated with it such as x$, and
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next
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9. When the ExtractWizard Exchange Emulation page changes from “Initializing” to “Emulating 
Exchange Server,” you are ready to start NetBackup. Do not click the Stop button until you reach the 
end of these instructions. 

 

10 Start the NetBackup client on the computer running ExtractWizard. 

On the File menu, click Specify NetBackup Machines and Policy Type. (For NetBackup 4.5, click 
Specify NetBackup Machines.) 

. 

11. 

12. licy Type tab.  

13. t the current 

14. up you wish to 

15. 

16. 

17. 

18. 

In the Specify NetBackup Machines and Policy Type dialog box, click the Client/Po

Under Client List, select the Exchange client that you want to restore from and make i
client. Click OK. 

On the toolbar, click the Select for Restore button, and then select the Exchange back
restore.  

On the Actions menu, click Start Restore of Marked Files.   

In the Restore Marked Files dialog box, click the Start Restore button. 

When NetBackup has finished, click OK and close NetBackup. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for CommVault Galaxy Backup & Recovery 

hange Emulation for ComExc mVault Galaxy Backup & Recovery and Exchange 2000/2003 
 

.  
The 

1. 

Important Note: CommVault Galaxy will not install the Exchange agent onto a non-server OS
Exchange agent is required for ExtractWizard to work.  

On the computer that will be running ExtractWizard, do one of the following:  

• Option 1: Install the Exchange System Management Tools and update the system
the Exchsrvr\bin\ directory. 

• Option 2

 path to include 

: Copy esebcli2.dll to the system path: winnt\system32 or windows\system
(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bi
Then set the registry key: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRes
with Value Name Esebcli2, Data Type REG_EXPAND_SZ, String Drive\Path

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

32.  
n directory.) 

tore\DLLPaths 
\Esebcli2.dll 

 
Example of Setting the Registry Key 

3. On the first page of the ExtractWizard, click Next.  

2. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 
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4. On the Method of Extraction page of the ExtractWizard, select Advanced Method and
Galaxy Backup & Recovery. Then click Next. 

 CommVault 

 

Connection Parameters page of the ExtractWizard appears. The 

 

5. Select the Exchange Server 2000 or Exchange Server 2003 option. 

6. Click Next.  
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7. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 
valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

 

8.  to “Emulating 
utton until you 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start CommVault Galaxy. Do not click the Stop b
reach the end of these instructions. 

 

Tip: You can refer 
to the “Restore 
to” information on 
this page when 
verifying it in 
CommVault 
Galaxy Backup & 
Restore later in 
this section. 
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9. Do one of the following: 

• For CommVault Galaxy 5.9: Make sure “iDA for Windows File Systems” software and “iDA for 
Exchange Database” software are installed on the computer running ExtractWizard.  

• For CommVault Galaxy 5.0: Make sure “CommVault Systems File System iDataAgent” software  
 on the 

staller. 

e Exchange agent 

10. d you wish to 
with 

Exchange 

11.  be the same 
s. 

12. d click Browse & 

13. Specify the appropriate browse time for your recovery: 

• Specify Browse Time 

14. pu
down menu.  

15. Click OK to show the browse data for your Exchange server. 

16. ore.  
 

a from under the Exchange Database tree node. 

17. Click the Recover All Selected button. 

18. The Restore Options for All Selected Items dialog box appears.  

19. Select the Restore to a Different Client option. 

20. Select the Restore Target Computer from the Select a Client drop-down menu. See previous step 8 
to verify that you are using the “Restore to” value from the Exchange Emulation page of the 
ExtractWizard. 

21. Click OK to close the Restore Options for All Selected Items dialog box. 

22. When CommVault has finished the restore, you can close CommCell Console. 

23. In ExtractWizard, click Stop and then click Finish. 

and “CommVault Systems Exchange Database iDataAgent” software are installed
computer running ExtractWizard. 

Notes:  

• You must run ExtractWizard in Advanced mode while running the CommVault in

• CommVault Galaxy will not install the Exchange agent onto a non-server OS. Th
is required for ExtractWizard to work.  

If you have already installed the Exchange Database iDataAgent for Exchange 5.5 an
emulate Exchange 2000/2003, you must reinstall the Exchange Database iDataAgent 
ExtractWizard running the correct emulation type. That is, the Exchange Server 2000 or 
Server 2003 option must be selected on the Connection Parameters page). 

Start CommCell Console on the computer you normally run your restores on. This can
computer as the one running ExtractWizard. The CommCell Console window appear

In the CommCell Browser, right-click the Exchange server you want to restore an
Recover. The Browse Options dialog box appears. 

• Browse the Latest Data 

In the Browse Options dialog box, select your Exchange server from the Client Com ter drop-

Select the storage groups to rest

Note: You can only restore dat
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Exchange Emulation for CommVault Galaxy Backup & Recovery and Exchange 5.5  
 
Imp a
The Exch

1. On . The 
easi bcli.dll to winnt\system32 or windows\system32. The 

ll file can be found on the Exchange Server in the Exchange Server\bin directory. 

2. 

3. 

4. On the Method of Extraction page of the ExtractWizard, select Advanced Method and CommVault 

ort nt Note: CommVault Galaxy will not install the Exchange agent onto a non-server OS.  
ange agent is required for ExtractWizard to work. 

the computer that will be running ExtractWizard, make sure edbbcli.dll is in the system path
est way to ensure this is to copy edb

edbbcli.d

Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

On the first page of the ExtractWizard, click Next.  

Galaxy Backup & Recovery. Then click Next. 

 

5. n the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option. O
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Click Next.  

On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be of the form x:\Path where x is a 
that has an administrative share associated with it such as x$, and Path is the comp
(if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

6. 

7. zard, specify a 
valid drive letter 

lete path to a folder 
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8.  to “Emulating 
utton until you 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start CommVault Galaxy. Do not click the Stop b
reach the end of these instructions. 

 

Do one of the following: 

• 

9. 

For CommVault Galaxy 5.9: Make sure  “iDA for Windows File Systems” software and “iDA for 
izard.  Exchange Database” software are installed on the computer running ExtractW

• For CommVault Galaxy 5.0: Make sure “CommVault Systems File System iDataAge
and “CommVault Systems Exchange Database iDataAgent” software are installed
computer running ExtractWizard. 

Notes:  
• You must run ExtractWizard in Advanced mode while running the CommVault in

• CommVault Galaxy will not install the Exchange agent onto a non-server OS. Th
is required for ExtractWizard to work.  

If you have already installed the Exchange Database iDataAgent for Exchange 2000/2
wish to emulate Exchange 5.5, you must reinstall the Exchange Database iDataAgent 
ExtractWizard running the correct emulation type. That is, the Exchange Server 5.5 
selected on the Connection Parameters page). 

Start CommCell Console on the computer you normally run your restores on. This can
computer as the one running ExtractWizard. The CommCell Console window appear

In the CommCell Browser, right-click the Exchange server you want to restore an
Recover. The Browse Options dialog box appears. 

nt” software 
 on the 

staller. 

e Exchange agent 

10. 003 and you 
with 

option must be 

11.  be the same 
s. 

12. d click Browse & 

13. Specify the appropriate browse time for your recovery: 

• Browse the Latest Data 

• Specify Browse Time 

Tip: You can refer 
to the “Restore 
to” information on 
this page when 
verifying it in 
CommVault 
Galaxy Backup & 
Restore later in 
this section. 
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14. In the Browse Options dialog box, select your Exchange server from the Client Computer drop-
down menu.  

 

15. Click OK to show the browse data for your Exchange server. 

16. 

n
Directory (DSA item). 

17. Click the Recover All Selected button. The Restore Options for All Selected Items di

18. Select the Restore to a Different Client option. 

19. Select the Restore Target Computer from the Select a Client drop-down menu. See previous step 8 
to verify that you are using the “Restore to” value from the Exchange Emulation page of the 
ExtractWizard. 

20. Click OK. 

21. When CommVault has finished the restore, you can close CommCell Console. 

22. In ExtractWizard, click Stop and then click Finish. 

 

Select the Exchange backup you want to restore. 

Note: You can only restore data from under the Exchange Database tree node. You ca not restore the 

alog box 
appears.  
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Exchange Emulation for UltraBac 

Emulation UltraBac and Exchange 2000/2003  
 the following

 for 
1. On the computer that will be running ExtractWizard, do one of :  

• Option 1: Install the Exchange System Management Tools and update the system path to include 
the Exchsrvr\bin\ directory. 

• Option 2: Copy esebcli2.dll to the system path: winnt\system32 or windows\system32.  
) 

Y_LOCAL_MACHINE\System\CurrentControlSet\Control\BackupRestore\DLLPaths 
EXPAND_SZ, String Drive\Path\Esebcli2.dll 

(The esebcli2.dll file is located on the Exchange Server in the Exchange Server\bin directory.
Then set the registry key: 
HKE
with Value Name Esebcli2, Data Type REG_

Note for Windows 2000: Use regedt32.exe to create a REG_EXPAND_SZ value. 

 
Example of Setting the Registry Key 

2. Start ExtractWizard. The computer running ExtractWizard is the Restore Target Computer. 

3. On the first page of the ExtractWizard, click Next.  
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4. On the Method of Extraction page of the E
Then click Next. 

xtractWizard, select Advanced Method and UltraBac. 

 

Connection Parameters page of the ExtractWizard appears. The 

 

5. Select the Exchange Server 2000 or Exchange Server 2003 option and click Next.  

6. On the Exchange Information Store Destination Folder page of the ExtractWizard, specify a 
location for the extracted files. This location must be a local drive of the form x:\Path where x is a 
valid drive letter that has an administrative share associated with it such as x$, and Path is the complete 
path to a folder (if a folder doesn’t exist, ExtractWizard will create it). Click Next. 
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When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start UltraBac. Do not click the Stop button until 

7.  to “Emulating 
ou reach the end 

of these instructions. 
y

 

Tip: You can copy 
the “Restore to” 
and “Log file 
path” information 
on this page and 
paste it into 
UltraBac when 
prompted later in 
this section. 

 

8. Start UltraBac Management Console on the computer you normally run your restores on. This can be 

x 

10. line Index dialog 
box appears. 

the same computer as the one running ExtractWizard. The UltraBac window appears. 

9. In UltraBac, click the Restore Wizard button on the toolbar. The Select Index Source dialog bo
appears. 

Select the appropriate source for your backup index, and click Next. The Select On
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11. e UltraBac window. 

12. You can only 

Select the correct online index to load for your backup. Click Next to return to th

In UltraBac, select the appropriate backup item to restore from the tree and list views. 
restore one storage group at a time. 

Note: You can only restore data from under the Exchange Agent tree node. 

Click the Restore button. The General Restore Options dialog box appears. 

Click the Exchange 2000, 2003 Options button. The Exchange 2000, 2003-Specific 
box appears. 

Select the Restore to Alternate Server option. In its Restore to box, enter the name o
Target Computer (i.e., the computer running ExtractWizard). See previous step 7 to 
using the “Restore to” value from the Exchange Emulation page of the ExtractWizard

Select the Alternate Temporary Log File Directory option. In its Restore to box, en
path. See previous step 7 to verify you are using the “Log file path” value from the Ex
Emulation page of the ExtractWizard. 

Click OK. 

13. 

14. Options dialog 

15. f the Restore 
verify you are 
. 

16. ter the log file 
change Server 

17. 

 

19. on. 

20. 

21. 

18. In the General Restore Options dialog box, click Next. The Restore Options dialog box appears. 

Click the Restore butt

When UltraBac has finished the restore, click Exit to close UltraBac. 

In ExtractWizard, click Stop and then click Finish. 
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Exchange Emulation for UltraBac and Exchange 5.5  
1. On the computer that will be running ExtractWizard, make sure edbbcli.dll is in the system path. The 

xchange Server in the Exchange Server\bin directory. 

2. get Computer. 

xt. 

easiest way to ensure this is to copy edbbcli.dll to winnt\system32 or windows\system32. The 
edbbcli.dll file can be found on the E

Start ExtractWizard. The computer running ExtractWizard is the Restore Tar

3. On the first page of the ExtractWizard, click Next.  

4. On the Method of Extraction page of the ExtractWizard, select Advanced Method and UltraBac. 
Then click Ne

 

5. On the Connection Parameters page of the ExtractWizard, select the Exchange Server 5.5 option 
and click Next. 
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On the Exchange Information Store Destination Folder page of the ExtractWi
location for the extracted files. This location must be of the form x:\Path where x is a v
that has an administrative share associated with it such as x$, and Path is the comp
(if a folder doesn’t exist, ExtractWizard will create it). Click Next. 

6. zard, specify a 
alid drive letter 

lete path to a folder 
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7.  to “Emulating 
you reach the end 

When the ExtractWizard Exchange Emulation page changes from “Initializing”
Exchange Server,” you are ready to start UltraBac. Do not click the Stop button until 
of these instructions. 

Tip: You can copy 
the “Restore to” 
information on 
this page and 
paste it into 
UltraBac when 
prompted later in 
this section. 

 

 

8. Start UltraBac Management Console on the computer you normally run your restores on. This can be 

9.  dialog box 

10.  dialog box 

11. e UltraBac window. 

12. 

13. 

14. . 

15. Select the Restore to Alternate Server option. In its Restore to box, enter the name of the Restore 
Target Computer (i.e., the computer running ExtractWizard). See previous step 7 to verify you are 
using the “Restore to” value from the Exchange Emulation page of the ExtractWizard. 

16. Under Databases to Restore, select the appropriate option: Public Store, Private Store, or Both. 

17. Click OK. 

the same computer as the one running ExtractWizard. The UltraBac window appears. 

In UltraBac, click the Restore Wizard button on the toolbar. The Select Index Source
appears. 

Select the appropriate source for your backup index. Click Next. The Select Online Index
appears. 

Select the correct online index to load for your backup. Click Next to return to th

Select the appropriate backup item to restore from the tree and list views.  

Notes:  

 You can only restore data from under the Exchange Agent tree node. 

 You cannot restore the Directory Store. 

Click the Restore button. The General Restore Options dialog box appears.  

Click the Exchange 5 Options button. The Exchange 5-Specific Options dialog box appears
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18. In the General Restore Options dialog box, click Next.  

In the Restore Option

 

19. s dialog box, click the Restore button. 

20. 

21. 

 

 

 

When UltraBac has finished the restore, click Exit to close UltraBac. 

In ExtractWizard, click Stop and then click Finish. 
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Organizing the Extracted Files for PowerControls 

For best results when using an online incremental or differential backup 

ne directory.  

ote: The two directories can be different. 

owerControls does not require .stm or .log files, but you should include them to ensure that all email data 
ered. You may get corruption errors if these files are not present. In other words, the quality of the 

covery is better if you include the .stm and log files. 

 

• Put the .edb and .stm files in one directory.  

• Put the associated log files (e.g., .log, .pat, .chk) in o

N

P
is recov
re
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is rControls window, and shows you how to preview 

messages, view details of an EDB or PST file, and change the view. 

ndow 

re described in the following sections.  

ote: In the illustration below, the Target pane displays a PST that acts as a container for restored files. 
Keep in mind that the Target pane could just as easily display an Exchange server.  
 

Th  chapter describes the parts of the main Powe

PowerControls Main Wi
The PowerControls main window is where you do most of your work. This window displays the source 
EDB or PST file(s) as well as the target PST file(s) or Exchange Server. The target acts as a container for 
the restored files. The various work areas and controls a

N

 

Source 
pane  

Menu Bar 

Toolbar 

Source 
Message 
List  

Target 
Message 
List 

Status Bar 

Target 
Pane  
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ane 
have 

not yet extracted Exchange data from a backup tape or disk, see Chapter 1, “Using the ExtractWizard 

Source Pane  
The Source pane displays the EDB file(s) that you extracted from a disk or tape backup. The Source p
can also display one or more PST files if you have purchased the “PST as Source File” agent. If you 

Direct Method,” or Chapter 2, “Using the ExtractWizard Advanced Method.” 

 

 

Source Message List 
The source message list displays the message items in the Outlook folder that you selected in the Source 
pane. This folder is one of the Outlook folders (e.g., Inbox, Contacts, Tasks). In the illustration below, the 
source message list displays the messages in an Inbox.  

 

The source message list displays metadata about the message items in six columns. The metadata includes 
file type; attachments, if any; message sender; subject; date; and status. The Sent Items folder also displays 
the “To” column. For more information on the message list, see “Sorting Messages in the Message Lists” 
on page 121. 

  Sources Root Node contains one or more source data stores 
that are pre-pended with a “SourceX” where X is a number starting 

ented for each additional source opened. You 
ces root node as your search source.  

with 1 and is increm
can select the Sour

 Source EDB File (e.g.,  ) contains the 
Exchange Information Store data that you extracted from a tape or 
disk backup. Click the plus sign (+) next to an EDB file to expand 
its contents.   

 Mailbox (e.g., ) contains the Outlook folders. Click 
the plus sign (+) next to a mailbox to expand its contents. 

Outlook Folders (e.g.,  Inbox,  Contacts,  Tasks) contain 
Outlook message items. Select a folder to view its contents in the 
source message list. 

Note: In the illustration on the left, the Source pane displays an 
EDB file, but it could just as easily display a PST file or even 
multiple EDB and PST files. 
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Target Pane 
The Target pane can display one or more target PST files and/or one target mailbox and public folders from
an Exchange Server. The target acts as a container for your restored files. If a target is a newly created PST
file, it defaults to 10 Outlook folders. If a target is an existing PST file or Exchange server, it shows 
whatever folders are in the target. It is into these folders that you paste and thus

 
 

 restore your message items. 
For information on restoring message items, see Chapter 7, “Restoring Exchange Data.” 

    
Target Pane for a PST File   

Target Message List (Restored Messages) 
 the message items in the Outlook folder that you selected in the Target 

 Target Pane for an Exchange Server  

 

The target message list displays
pane. If the target is a newly created PST file, the Outlook folders and message list will be empty. If the 
target is an existing PST file or Exchange server, or if you have restored message items to a newly created 
PST file, you can select a folder in the Target pane to display messages in the target message list.  

 
Target Message List Displaying Restored Messages 

The target message list displays metadata about the message items in five column  of six columns s (instead
in the source message list). The metadata includes file type; attachments, if any; message sender; subject; 
and date. The Sent Items folder also displays the “To” column. For more information on the message list, 
see “Sorting Messages in the Message Lists” on page 121. 
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Menu Bar  

 

The menu bar contains most of the PowerControls commands. The menu commands, submenu commands, 
and resulting dialog boxes are discussed fully in the chapters that focus on those specific commands. See 
the index to quickly locate the pages on which a menu command is discussed. 

Toolbar 

 

The ten buttons on the toolbar perform the following functions: 

 
Open Source button displays the Open dialog box, which lets you navigate to and select a 
source Exchange Database (EDB) or PST file. This EDB or PST file contains the message items 
you want to restore.  

 
Open Target PST button displays the Open dialog box, which lets you navigate to and select a 
target Personal Folders (PST) file. The target PST file is a container for restored message items. 

 
Open Target Exchange Server button displays the Connect to Exchange Server dialog box, 
which lets you connect to a target Exchange server. The target Exchange server is a container for 
restored message items. 

 
Copy button copies into the Clipboard the selected message(s) in the source message list; or the 
selected folder, mailbox, or EDB file in the Source pane. 

 
Paste button pastes the items from the Clipboard into the selected folder in the Target pane. If 
you wish to retain the directory structure of the restored messages, you must use the Paste 
Special command instead of the Paste command or Paste button. 

 
Export button displays the Export dialog box, which lets you export messages to a local or 
network drive destination. You can choose to save exported messages as plain text files (.txt) or 
as Microsoft Outlook files (.msg). 

 
Search button displays the Find dialog box, which lets you specify the desired search criteria for 
finding messages in the Source pane. 

 
Preview Pane button displays the preview pane on the PowerControls main window so you can 
read a message without opening it.   

 
View Help button displays PowerControls Online Help, which includes all of the information in 
this user guide and more. Online Help lets you quickly access this information by using a 
Contents, Search, or Index tab. 

 
Ontrack Web Site button takes you to the Ontrack Web site (www.ontrack.com), providing you 
with additional information on products and services by Kroll Ontrack Inc. 
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Status Bar 
 

A     B          C 

The sections in the status bar provide the following information: 

A  One of the following: total number of message items in the selected folder, error messages, copy 
information, or description of selected menu command. 

nge server. 

Previewing and Opening Messages 
In the preview pane, you can read the contents of a message item and open attachments. You can preview a 

 located in either the source message list or the target message list. The information displayed in 
t ssage Header is different for messages, calendars, contacts, tasks, and distribution lists. 

 the preview pane 

•  the View menu, click Preview Pane. 

B   Status while loading a source EDB file, a target PST file, or a target Excha

C   Status while displaying the contents of a folder (e.g., Inbox). 

message
he Me

To open
Do one of the following: 

 On

• On the toolbar, click the Preview Pane button . 

To hide the preview pane 
• Repeat one of the previous steps. 

Tip: Hiding the preview pane will allow you to scroll through messages faster. 

lay a message in the preview pane 
In the source or target message list, select a message. 

n the preview pane.  

To disp
1. 

2. Ope

 

e. 

Preview pane for a message 

To open a message in its own window 
• In the source or target message list, double-click a messag
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Opening Attachments  

view the selected attachment (e.g., to view an .xls file attachment, PowerControls will launch MS Excel).  

Note: PowerControls cannot view attached embedded graphics in HTML messages. 

To open an attachment in an open message 
1. In the message list, double-click a message that has the Attachment icon 

If you have the appropriate program installed on your computer, PowerControls  will load the application to 

If no associated program is available for the attachment file type, PowerControls will present a message 
dialog box saying the attachment cannot be viewed.  

 next to its name. 

2. Click the Attachment button  on the right side of the message header. A pop-up window lists the 
attachments for the selected message. 

3. Cl k

To open a
1. In the

ic  the name of the attachment you want to view. 

n attachment in the preview pane 
 message list, select a message that has the Attachment icon  next to its name. 

2. Open the preview pane. In the PowerControls main window, click the Preview Pane button . In the
dialog box, select the Preview check box. 

 
Find 

3. Click the Attachment button  on the right side of the message header in the preview pane.  
A pop

4. lick

Savin
A “sa  well 
as on t e pape ents dialog box lists the attachments for 
the selecte

To sav  a
1. 

-up window lists the attachments for the selected message. 

 the name of the attachment you want to view. C

g Attachments 
ve at
h

tachments” option is available on the File menu and paperclip menu of an open message, as
rclip menu of the preview pane. The Save Attachm

d message and lets you select the attachments you want to save.  

e ttachments in an open message 
 source or target message list, double-click a message that has the Attachment icon In the  next

e. 
 to 

its nam

2. In the 

• On the File menu, click Save Attachments. 

• Click the Attachment button 

open message, do one of the following: 

 on the right side of the message header, and then click Save 
Attachments.  

3. In the Save Attachments dialog box, select one or more attachments, and click OK.   

4. In the Browse For Folder dialog box, select a location for the attachment(s), and click OK. 
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To save attachments in the preview pane  
1. In the source or target message list, select a message that has the Attachment icon  next to its 

name. 

2. In the preview pane, click the Attachment button  on the 
then click Save Attachments.  

right side of the message header, and 

OK. 

Changing the View 
e toolbar or status bar, by using split 

sily hide 
them. 

atus bar 
us Bar. The check mark no longer appears next to the name 

To view the toolbar or status bar 
k Toolbar or Status Bar. The check mark appears next to the name of the 

Resizing Panes Separated by a Split Bar 
cal double line that separates two panes) to increase the area 

adjacent pane. The Source pane, 
review pane all border a split bar. 

To resize panes separated by a split bar 
1. Position the cursor over a split bar between two panes until a double arrow 

3. In the Save Attachments dialog box, select one or more attachments, and click OK.   

4. In the Browse For Folder dialog box, select a location for the attachment(s), and click 

You can change the view in the PowerControls window by hiding th
bars; by sorting message lists; and by refreshing the screen. 

Viewing or Hiding the Toolbar and Status Bar 
The toolbar and status bar appear by default in the main PowerControls window, but you can ea

To hide the toolbar or st
• On the View menu, click Toolbar or Stat

of the toolbar or status bar. 

• On the View menu, clic
toolbar or status bar. 
 

You can use a split bar (the horizontal or verti
hwit in one pane while simultaneously decreasing the area within the 

source message list, Target pane, target message list, and p

 appears. A vertical 
double arrow  appears if you position the cursor over a horizontal split bar. 
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arget message list and the preview pane 

2. Drag the split bar until the two panes are the desired size. 

Before dragging the split bar between the t

 

 
s 

 
After dragging the split bar upward
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e Lists Sorting Messages in the Messag
You can sort messages in the source and target message lists based on attachments, mess e sender, 

ect, date
ag

subj , and status. In addition, the source message list lets you sort messages based on status, and the 
Sent Items folder lets you sort items based on the “To” heading. Sorting messages on the From column, 

ficfor example, can help to identify messages from a speci  sender. 

 

To sort a message list 

indicates that the messages appear in descending (Z-A) order. 

a d on that column heading, click the column heading again. 

An ex es 
• If you click the attachment 

1. Click a column heading to sort the messages based on that heading. For most headings, an arrow 
appears indicating the sort direction. An up arrow indicates that the messages appear in ascending  
(A-Z) order. A down arrow 

2. To reverse the order of the mess
Notice the arrow reverses direct

ges base
ions. 

ample of sorting messag
 column heading, messages are sorted in ascending order based on this 

at messages with attachments appear at the top 
ts appear at the bottom of the document list. If 

heading, even though no arrow appears. This means th
of the message list, while messages with no attachmen
you click the attachment  column heading again, the order is reversed. 

Note: The view settings (sort order and column width) for a folder or mailbox are saved until you close the 
data store. 

You et Exchange server. 
That’s because the information on the server may change while you are connected. 

To refresh the screen 
Do one of the following: 

• On the View menu, click Refresh. 

• Press the F5 key. 

Refreshing the Screen 
 may wish to refresh the screen occasionally when you are connected to a targ

   121



Chapter 3: Looking at the Interface 

Viewing the Properties of an EDB File, PST File, Folder, 
or Mailbox 
PowerControls makes it easy to view the properties of a source PST file, EDB file, mailbox, or folder. 

To view the properties of an EDB file, PST file, mailbox, or folder 
1. In the Source pane, right-click an EDB file, PST file, mailbox, or folder. 

2. On the shortcut menu, click Properties. A properties dialog box appears. 

 
Properties of an EDB 
 

File 

 
Properties of a PST File 
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Properties of a Mailbox 
 

 

An altern

disp

PST file. 

spl

Properties of a Folder 

ate way to view the properties of an EDB or PST file 
Once you have viewed the properties of the source EDB or PST file as described above, you can then 

lay the properties in the preview pane. 

1. In the Source pane, select the source EDB or 

2. Open the preview pane to di ay the properties. 

 
Properties of an EDB File 
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Performing an Integrity Check 
You can perform an integrity check on messages, folders, mailboxes, PST files, and EDB files. During the 

nd 
checksum scan prior to the property verification. 

essage 
). 

2. On the Edit menu, click Integrity Check. The PowerControls Integrity Check dialog box appears. 

3. 

4. 

integrity check, PowerControls will verify that it can read all folder and message properties from the 
selected source. If the selected source is an EDB file, PowerControls will perform a database structure a

To perform an integrity check of an EDB file, PST file, mailbox, folder, or m
1. In the Source pane, select an EDB file, PST file, mailbox, folder, or message(s

Click Print to print a copy of the integrity check. 

Click Save to save a copy of the integrity check to file. 

 
An integrity check of an EDB file 

Po essages appear 
un from the EDB 
file du ssages.  

Viewing Deleted Messages 
werControls can view and restore deleted messages that are held in the EDB file. These m
der the Status column in the source message list. If deleted messages have been purged 

e to the deleted retention schedule, PowerControls cannot view or restore these me
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Setting Preferences 
The Preferences dialog box allows you to streamline PowerControls operations. Most of the preference 
settings in the three tabs are selected by default. There are two exceptions: the “Display new PST when 
PST limit is reached” setting in the Options tab, and the “Enable Tamper-Proof Target” setting in the 
Security tab. If you change the settings, they are stored and reloaded on the next run of PowerControls.  

To change preference settings  
1. On the Edit menu, click Preferences. 

2. boxes in the three tabs, as desired. 

Options Tab 

Select or clear the check 

 

• Run PowerControls Data Wizard on startup: The Da
PowerControls. 

ta Wizard will launch every time you open 

 reached: PowerControls will 
automatically create new folders (e.g., Inbox) when the 16,383 messages/folder limit is reached. After 
PowerControls creates a new folder, it will continue to restore Exchange data where it left off. For 
more information, see “Limits for PST and Folder Targets” on page 160. 

• Check for duplicate messages during copy: When restoring Exchange data, PowerControls will not 
copy duplicates of a message to the destination folder if a message already exists in the destination 
folder. Selecting this preference setting results in slower copy performance. 

• Check for duplicate messages during search: PowerControls will not return duplicates of a message 
during a search. For example, if the same message exists in two or more data stores, only the first 
message found will be listed in the search results. Selecting this preference setting results in slower 
search performance. 

• Display new PST when PST limit is reached: When the limit for a PST is reached in the Target pane, 
y displays the overflow PST. 

•  This box displays the current location of the license .ini file. To put this file in a 
different location, click the Browse button and navigate to the desired location. There are two ways to 
manage the location of the license.ini file: 

• Create new PST folders when PST message/folder limits are

PowerControls automaticall

License file name:
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⇒ Multiple Copies of PowerControls: Put one license.ini in the PowerControls program directory 
of each PowerControls installation. 

⇒ Single Copy of PowerControls:  Put one license.ini in a single network folder to which all 
PowerControls installations make reference.   

For more information about the license .ini file, see “The License .ini File” on page 6. 

Security Tab 
The options in this tab are modifiable by default only by users that belong to the Administrator Group.  
The options are stored in the registry: HKEY_LOCAL_MACHINE\software\ontrack\powercontrols.  
The PowerControls Installation program sets this registry key to have read/write access to users in the 
Administrators group and read-only access by any user in the Users group.   

 

• Allow preview of messages: If this option is not checked, you will not have the ability to open or 
preview messages in the source or target. 

• Enable Tamper-Proof Target: If this option is selected, PowerControls will not allow you to delete 
messages or folders in the target or have the ability to rename folders in the target. You will only have 
the ability to add (copy) to the target.  

• Allow Bcc field to be included when restoring messages: If this option is selected, PowerControls 
will include Bcc information when restoring messages. This means that a recipient will be able to see 
Bcc recipients that he or she was not intended to see. It also means that searching with the “Sent to” 
option will return messages for Bcc recipients. 
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Warnings Tab 

 

• Show warning when logs specified but not found:
EDB file if no .logs files were found at the specified di

• Show warning when no log file path specified: PowerC
file if a .log file path has not been specified. 

• Show warning when copying to Exchange Server root:
about to copy a large amount of data to the Exchange se

 PowerControls will warn you when opening an 
rectory. 

ontrols will warn you when opening an EDB 

 PowerControls will warn you when you are 
rver root. 
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Chapter 4: Starting PowerControls 
You can open a source Exchange Database (EDB) file or PST file and specify a target PST file or target 
Exchange server by employing one of the following methods: 

• Use the PowerControls Data Wizard. 

• Open the source database and target mailboxes from the PowerControls main window. 

Note: You cannot open the same PST file as both source and target. 

Running the PowerControls Data Wizard 
The first time you start PowerControls, the PowerControls Data Wizard starts. The Data Wizard guides you 

o  
spec

up E rd reads previous Exchange server backups and 
restores EDB files to any machine, volume, or folder. For more information, see Chapter 1, “Using the 

Data Wizard: Welcome Page 
1. Click the Start button, and then point to Programs. Point to Ontrack, point to PowerControls, and 

then click PowerControls. The PowerControls Data Wizard appears.  

2. If you do not want to run the Data Wizard every time you start PowerControls, clear the Run On 
Startup check box. Click Next. 

thr ugh the loading of Exchange Database (EDB) or PST files into PowerControls, and shows you how to
ify the target PST file or Exchange server.  

Before Using the Data Wizard: Use the PowerControls ExtractWizard if you have not yet restored backed-
xchange Information Store data. The ExtractWiza

ExtractWizard Direct Method.” 
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Data Wizard: Source Path Selection 
n the Source Path Selection page of the Data Wizard, specify the source EDB file path along with its log 
le path and temporary file path. Or specify the source PST file path. If you do not want to open a source 

EDB or PST file at this time, click the Skip button. 

Note: Due to the database nature of the PST file and MAPI subsystem, PSTs opened as source will be 
modified. 

To specify a source file 
1. In the Source File box, use the Browse button to find the source EDB file or the source PST file.  

2. If you specified a PST file path, proceed to step 5. PST files do not require log file or temporary file 
paths. 

3. In the Log File Path box, use the Browse button to find the log files associated with the source EDB 
file.  

Important Note: After you select an EDB file, the Log File Path box defaults to the source EDB file 
path, even if the log files are not in the same directory as the source EDB file. Therefore, make sure 
you enter the correct log file path in the Log File Path box. 

4. In the Temporary File Path box, accept the default location for .idx and .dat files, or specify a new 
location if they require more hard drive space. For more information, see "Guidelines for Selecting an 
Exchange Database" on page 131.  

5. Click Next. 

O
fi
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Guidelines for Selecting an Exchange Database 
1. For best results when using an online incremental or differential backup:  

• Put the .edb and .stm files in one directory.  

e directory.  

ent. 

 that all email 
data is recovered.  

2. If you are using an offline backup: You need to use the .edb and .stm files. To ensure that all email 
data is recovered, you should also include all .log files, as well as .pat and .chk files if they exist. 

.log and .pat files to 

dat and .idx files. These files may require hard drive space 
equal to the size of the .log files. Therefore, you may need to change the default file path for .idx and 

, it 
 the first time you open an .edb file from a directory that contains log 

files. Each time you reopen the .edb file, PowerControls uses the information in the .dat and .idx files 

• Put the associated log files (e.g., .log, .pat, .chk) in on

Note: The two directories can be differ

PowerControls does not require .stm or .log files, but you should include them to ensure

PowerControls performs its own verification process and will include the 
determine if it needs them to recover the data. 

3. For best results when specifying a temporary file path for .idx and .dat files: Make sure you have 
a sufficient amount of hard drive space for .

.dat files if you need more space. 

PowerControls never modifies an .edb file or its associated files (e.g., .log, .stm, .pat, .chk); however
does create .dat and .idx files

so it can open the .edb file quicker. 

Note: Exchange 5.5 does not use .stm files. 
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Data Wizard: Target Type and Path Selection 

ge server as the target for restored data. An option to 
open Public Folders is available upon connection to an Exchange server. 

 the Skip button if you do not want to select a target file at this time. 

the target for restored data 

On the Target Type and Path Selection page of the Data Wizard, specify the type and path of the target 
file you will be using as the container for your restored data. You have two choices: 1) specify a PST File 
as the target for restored data; or 2) specify an Exchan

Note: Click

To specify a PST File as 
1. Select the PST File option. 

 

2. Do one of the following: 

• If you know the target PST file path, type it in the Target PST File Path box. 

• Click the Browse button to open the Create PST File dialog box, and navigate to the desired 
location. Then create a new PST file by typing a name in the File name box, or select an existing 
PST file. Next, click Open. The path of the target PST file will appear in the Target PST File 
Path box.  

3. Click Next. 
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To specify an Exchange server as the target for restored data  
1. Select the Connect to Exchange Server option.  

 

2. 

ype the mailbox and server names.  

Tip: If you don’t know the full name of the mailbox, type a sub-string (e.g., the first letter of the 
mailbox) in the Mailbox Name box, and click Next. In the Check Name dialog box that appears, select 
the mailbox from the list, and click OK. 

4. If you are not connected to a domain, the Enter Password dialog box appears. In this dialog box, type 
a user name that has full rights to the mailbox, a password, and a domain name. Then click OK. This 
dialog box may appear again, which will require you to reenter this information. 

The Connect to Public Folders check box is selected by default. This feature allows you to open 
public folders as a target for restoring public folders or messages. If you do not want to restore to 
public folders, clear this check box. For more information, see “Restoring to Public Folders” on page 
179. 

3. For Mailbox and Server Name boxes, t

 

5. Click Next. 
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Data Wizard: Now Processing Data File 
The Now Processing Data File page of the Data Wizard reports the processing of the EDB file in three 
stages: pre-scanning the log files (integrity check); scanning the log files, (i.e., playing the log files); and 
hashing the EDB file (building a folder hierarchy).  

 

When the processing is complete, PowerControls automatically proceeds to the next page. 

Note: If PowerControls encounters bad or missing log files during log playing, you will be given the option 
to continue without playing the logs. If you choose to continue, PowerControls will process the EDB 
without logs.  
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Data Wizard: Completing the Data Wizard 
On the last page of the Data Wizard, click Finish. This page of the Data Wizard lists the source file results 
and the target file results. 

 
t page of the Data Wizard for a target PST file Las

 

 
t ata Wizard for a target Exchange server Las  page of the D
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Looking at the PowerControls Main Window after Using the Data Wizard 
In the PowerControls main window, the Source and Target panes will now contain a source EDB file 
and/or PST file and a target PST file and/or a target Exchange server. 
 

      
  Source pane for a PST file    Source pane for an EDB file  

 

    
 Exchange server 

Returning to the PowerControls Data Wizard 
When working in the PowerControls main window, you can return to the Data Wizard at any time. 

To open the Data Wizard from the PowerControls main window 
• On the File menu, click Use Wizard. 

Target pane for a PST file    Target pane for an
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Opening the Source Database and Target Mailboxes 

Instead of using the Data Wizard to open the source databases and target mailboxes, you can open them 
from the PowerControls main window. 

rols Extract backed-up 
Exchange Information Store data. The ExtractWizar  backups and 
restores EDB files to any machine, volume, or fold 1, “Using the 
ExtractWizard Direct Method.” 

Note: Due to the database nature of the PST file and  source will be 
modified. 

To open a source file 
1. Do one of the following: 

• On the File menu, click Open Source. 

• On the toolbar, click the Open Source button

from the Main Window 

Before You Proceed: Use the PowerCont Wizard if you have not yet restored 
d reads previous Exchange server

er. For more information, see Chapter 

 MAPI subsystem, PSTs opened as

 . 

EDB file in the dialogImportant Note: Before you select a source ox below, see “Guidelines for  b
Selecting an Exchange Database” on page 131. 

 

 find a source EDB or PST file.  2. In the Source File box, use the Browse button to

3. If you selected a PST file, proceed to step 6. PST files do not require log file or temporary file paths. 

 the log files associated with the source EDB 
file.  

Important Note: After you select an EDB file, the Log File Path box defaults to the source EDB file 
path, even if the log files are not in the same directory as the source EDB file. Therefore, make sure 
you enter the correct log file path in the Log File Path box. 

4. In the Log File Path box, use the Browse button to find
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5. In the Temporary File Path box, accept the default location for .idx and .dat files, or specify a new 
an 

rce pane. 

location if they require more hard drive space. For more information, see "Guidelines for Selecting 
Exchange Database" on page 131.  

6. Click OK. The EDB or PST file appears in the PowerControls Sou

 

ip: You can use Windows Explorer to open an EDB file. In Windows Explorer, double-click the EDB file 
or drag into the PowerControls Source pane. 

To open an existing target PST 
1.  Do one of the following: 

• On the File menu, point to Target PST, and click Open Existing. 

• On the toolbar, click the Open Target PST button 

Source pane for an EDB

T

 file 

.  

2. In the Open Existing PST dialog box, navigate to the desired location, and select an existing PST file. 

3. Click Open. The PST file appears in the PowerControls Target pane. 

Tip: In Windows Explorer, you can drag a PST file into the PowerControls Target pane. Note that double-
clicking a PST file will not op in ows XP, Outlook XP, or Outlook 2003. 

 
 enu, point to Target PST, and click Create New. 

cation. You may want to create a new 

PowerControls Target pane. 

en it when us g Wind

To create a new target PST
1. On the File m

2. In the Create PST File dialog box, navigate to the desired lo
folder. 

3. In the File name box, type a name for the new PST file.  

4. Click New. The PST file appears in the 
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Note: With Outlook 2003, you will have to choose between the 97 and 2003 version of the PST. 

 
Target pane for a PST file  

oTo 
1.  Do one of the following: 

nge Server. 

• On the toolbar, click the Open Target Exchange Server button 

pen a target Exchange Server 

• On the File menu, click Open Target Excha

.  

The Connect to Exchange Server dialog box appears. 

 

2. The Connect to Public Folders check box is selected by default. This feature allows you to open 
nt to restore to 
c Folders” on page 

179. 

f you don’t know the full name of the mailbox, type a sub-string (e.g., the first letter of the 

4. rd dialog box appears. In this dialog box, 
type a user name that has full rights to the mailbox, a password, and a domain name. Then click OK. 
This dialog box may appear again, which will require you to reenter this information. 

public folders as a target for restoring public folders or messages. If you do not wa
public folders, clear this check box. For more information, see “Restoring to Publi

3. For Mailbox and Server Name boxes, type the mailbox and server names.  

Tip: I
mailbox) in the Mailbox Name box, and click OK. (Log on to the Exchange server if prompted; see 
step 3.) In the Check Name dialog box that appears, select the mailbox from the list, and click OK. 

If you are not authenticated to the domain, the Enter Passwo
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5. ver appears in the PowerControls Target pane. Click OK. The Exchange ser

 
Target pane for an Exchange server 

 

O ening Multiplep  Sources and Targets 
You n he Target pane. Sources 
include EDB and PST files. Targets include PSTs and Exchange servers. See the instructions for using the 
Dat i  so or one target at a time. 

 ca  display multiple sources in the Source pane and multiple targets in t

a W zard or the PowerControls main window to open one urce 

   
le souMultip rces     Multiple targets 

me. Note: Only one target Exchange mailbox can be opened at a ti
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Cl
You ca werControls main window. 

To
1.  or PST file. 

2. 

• On the File menu, click Close Store. 

 the context menu click Close Store. 

To
1. Sources root node. 

2. Close All Stores. 

 PST file or Exchange database. 

2. 

• On the File menu, click Close Store. 

ick Close Store. 

Deleting Items in the Target Pane  
Using the Delete key to remove an item (e.g., folder, message) from the PowerControls target pane will 
permanently delete the item, similar to using Shift+Delete in Microsoft Outlook. 

osing Sources and Targets 
n close sources and targets from the Po

 close a source 
In the Source pane, select a source EDB

Do one of the following: 

• Right-click the selection, and on

 close all sources 
In the Source pane, right-click the 

On the context menu, click 

To close a target 
1. In the Target pane, select a

Do one of the following: 

• Right-click the selection, and on the context menu cl
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 lets you search a source EDB or PST file for message items that are defined by such 

message creation dates. In addition, this dialog 
x l ST file, one or more mailboxes or folders (e.g., 
o  search results. 

The Find dialog box
criteria as keywords, message senders and recipients, and 
bo ets you define the scope of your search: an EDB or P
Inb x), dates, or even previous

 

 conditions is met: 

• At least one Search in check box is selected. 

• The Sent from or Sent to box contains at least one character. 

• The Dated after or Dated before check box is selected. 

2. Each Search in check box that you select is run as a separate query, and the results of the query are 
combined (i.e., OR’d together). For example, if you enter “solution” in the Search for words box, and 
then select the Message Subject and Message Body check boxes, PowerControls will return messages 
that contain “solution” in either their message subject or message body. 

3. If you select one or more Search in check boxes, but specify no additional search criteria, 
PowerControls will return all of the messages in the folder(s) undergoing the search. 

4. PowerControls can search multiple information stores at the same time. In the Find dialog box, click 
Browse and you will see a tree view of all of the open source data stores. You can then select multiple 
mailboxes or folders to include in your search. 

Guidelines for Using the Find Dialog Box 
1. The Find Now Button only becomes available if at least one of the following
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5. PowerControls will not return duplicates of a message during a search as long as the “Check for 
duplicate messages during search” preference is selected. For example, if the same message exists in 
two or more data stores, only the first message found will be listed in the search results. For more 
information, see “Setting Preferences” on page 125. 

Searching for Messages 
1. In the Source pane, select the folder (e.g., EDB or PST file, mailbox, Inbox) you want to search. The 

folder(s) you select defines the scope of your search. 

2. Click the Search button  to display the Find dialog box. The name of the folder you
appears next to the Search in folder box. 

The first time you search for messages, the Search in folder option is automatically sele
information on using the Search in results option, see “Searching Within Results” on

 selected 

cted. For 
 page 147. 

 

3. If you want to select multiple mailboxes or folders to search, click the Browse button. In the Select 
Folder(s) dialog box, select the items you want to search. In the illustration below, two mailboxes 
have been selected. 
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Note: If you select the Search Subfolders check box, PowerControls will include subf

4. Click OK to return to the Find dialog box. 

olders in the search. 

In the following illustration, the Search in folder box now displays “Multiple folders selected.” 

 

5. ecute a keyword In the Search for words box, enter one or more words or phrases if you want to ex
search. Keep in mind the following points: 

• Put a space between words or phrases to perform an AND operation (i.e., all words must be 
matched in order to include a message with the search results). 

• Put a comma between words or phrases to perform an OR operation (i.e., only one of the wor
must be matched in order to include a message with the search results). 

ds 

• Put quotation marks around word phrases (i.e., the exact phrase must be matched in order to 

a

re 

6. 

include a message with the search results). 

Ex mple: Search for words: dog cat mouse, rat 

Search results: Messages that contain [“dog” AND “cat” AND “mouse”] OR [“rat”] a
included in the search results. 

In the Exclude words box, enter words or phrases if you want to perform a NOT operation. If 
matched, these words or phrases will exclude a message from the search results. The rules for using 

ain [“dog” AND “cat” AND “mouse”] OR [“rat”] 
search results. 

spaces, commas, and quotation marks apply when excluding words from a search. 

Example: Search for words: dog cat mouse, rat 

Exclude words: bird 

Search results: Messages that cont
BUT NOT [“bird”] are included in the 
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7. For Search in, select one or more of the following check boxes: Message Subject, Message Body
Attachment File Name(s), or Attachment Text. Each Search in check box that you select is run as a
separate query, and the results of the query are combined (i.e., OR’d together).  

, 
 

Note about searching within attachments: PowerControls does not search within archive file types 
such as .zip or .rar files. For more information, see “Searching Within Attachments” on page 150. 

nt to box is 

g the Sent from and Sent to boxes. 

ed oth 

10. When you have finished specifying search criteria, click Find Now. The results of your search appear 
in the message list. 

11. To preview the messages returned by the search, click the Preview check box. 

8. In the Sent from and Sent to boxes, enter the appropriate names, if desired. Using the Se
particularly useful if you are trying to find a message sent to multiple people. The rules for using 
spaces, commas, and quotation marks apply when usin

9. For Dated after and Dat  before, select the appropriate check box, if desired. You may select b
check boxes. Then type or select the part of the date you want to change. 

Dated after: Searches for documents dated on or after the selected date. 

Dated before: Searches for documents dated on or before the selected date. 
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Searching Within Results 
The Search in results option lets you refine the search process using the previous search results. 

To s
1. To make the Search in results option available, you must perform at least one search.  

2. Modify the search criteria as desired. For information on specifying search criteria, see “Searching for 
Messages” on page 144. 

3. Select the Search in results option at the top left of the Find dialog box. 

4. Click Find Now. The results of your new search appear in the message list.  

5. To preview the messages returned by the search, click the Preview check box. 

earch within results 
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Vi wing Previous Search Results 
 can click the Previous button multiple times to return to any previous search cri

e
You teria and search 
results. This button becomes unavailable when there are no more previous results.  

To v

2. 

Cle
If y he Find dialog box are 
return past search results are 

Saving and Using Search Profiles 
ng the search criteria in 

future searches. There are two menu commands that allow you to perform these functions: “Save Criteria” 
and “Use Previous Criteria.” In addition, if you want to modify the search criteria in a search profile, you 
can edit the text file with a text editor. 

iew previous search results 
1. Perform at least two searches so the Previous button becomes available.  

Click Previous. The results of the previous search appear in the in the message list.  

3. You can now view the previous search, or you can modify the search criteria and conduct a new 
search. For information on specifying search criteria, see “Searching for Messages” on page 144. 

aring Fields and Clearing Results 
u click the Clear Fields button, all of the search criteria that you entered in t
ed to the default settings. If you click the Clear Results button, all current and 

o

cleared.  

PowerControls allows you to save search criteria to a text file for the purpose of usi

 

When creating a search profile, you can save the following search criteria. The “Search For,” “Exclude 
Words,” “Sent from,” and “Sent to” fields have a maximum of 4,095 characters. 

• Search for words 

• Exclude words 

• Search in 
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• Sent from 

• Sent to 

• Dated after 

• Dated before 

To create a s

t file.  

4. Click Save. 

To edit a search profile 
1. Locate and open the search profile that you want to edit. 

earch profile 
1. Open the Find dialog box, and enter search criteria. 

2. On the File menu in the Find dialog box, click Save Criteria. 

3. In the Save As dialog box, specify a name and location for the search profile tex

 

for your search. 

4. Click Open. The Find dialog box will be populated with the search criteria specified in th
profile. 

2. Modify the search criteria as desired and save the text file.  

To use a search profile when performing a search 
1. Open the Find dialog box. 

2. On the File menu in the Find dialog box, click Use Previous Criteria. 

3. In the Open dialog box, locate and open the search profile that you want to use 

e search 
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Using Multiple Search Windows  
n of 

r the number of 
concurrent searches you can initiate.  

 the same mailbox, you 
y

In th s 
feature supports Unicode text and is available for both EDB and PST sources. PowerControls supports 

file types. For a list of supported file types, see the 

PowerControls allows you to open multiple instances of the Find dialog box to search any combinatio
information stores at the same time. There is no limit other than system resources fo

Note: If you are using multiple instances of the Find dialog box to search within
ma  notice a slowdown in performance. 

Searching Within Attachments  
e Find dialog box, you can search the text of email attachments. The Searching within Attachment

Microsoft Office documents and many other popular 
FAQs at www.ontrack.com/powercontrols/. 

Note about the licensing agent: The “PC Agent for Advanced Searching” must be enabled in order to 
search attachments. For more information, see “Enabling the Licensing Agents” on page 5. 

 

To search within attachments 
1. In the Find dialog box, select the Attachment Text check box. 

2. Specify other desired search criteria. For more information, see “Searching for Messages” on page 

3. Click Find Now. If PowerControls matches a keyword or phrase in the text of the attachment, it will 
as it would if it found a keyword or phrase in the body or subject of a message.  

144. 

return a “Hit” just 

 150 



Ontrack® PowerControls™ 4.0 User Guide 

Exceptions When Searching Within Attachments 
ing within attachments, PowerControls searches only for embedded messages one level deep. 

o arch for the following items: 

r other embedded objects) within attachments 

e.g., .zip, .rar) 

 (e.g., spreadsheet embedded in a message body) 

• Metadata associated with files (e.g., author and company information in an .xls file) 

t erControls Features Available Through the 

ontrols 

stalled on your 
ent file type, 

Attachments” 

cal or network 
crosoft Outl k 

files (.msg).  

To export messages from the Find dialog box 

he messages you want to export. 

When search
It d es not se

• Attachments (o

• Archive files (

• Embedded OLE objects

• Binary files (e.g., .dll, .exe, .jpg, .mp3)  

O her Pow
Find Dialog Box 
In addition to the search features described in the previous sections, there are several PowerC
features available through the Find dialog box. 

Opening and Saving Attachments in the Find Dialog Box 
To open an attachment’s file type in the Find dialog box, you must have an application in
computer that can perform this function. If no associated program is available for the attachm
PowerControls will present a message dialog box saying the attachment cannot be viewed.  

For instructions on opening and saving attachments, see “Opening Attachments” and “Saving 
on page 118. 

Exporting Messages from the Find Dialog Box 
The Export feature allows you to copy individual messages from the Find dialog box to a lo
drive destination. You can choose to save exported messages as plain text files (.txt) or Mi oo

1. In the Find dialog box, perform a search. 

2. In the Results area, select t

3. On the File menu in the Find dialog box, click Export. 

4. In the Export dialog box, specify options and click Export. For more information on the export 
options, see Chapter 6, “Exporting Messages.”  
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Restoring Messages from the Find Dialog Box 

g 
s. 

storing Exchange Data.”  

s in the Find Dialog Box 
 on one or more messages in the Results area. 

1. In the Find dialog box, perform a search. 

. 

3. On the Edit menu in the Find dialog box, click Integrity Check. The Integrity Check dialog box 
appears.  

For instructions on performing integrity checks on messages, folders, mailboxes, PST files, and EDB files 
in the main PowerControls window, see “Performing an Integrity Check” on page 124. 

The results of conducting a search appear in the message list in the Find dialog box. You can restore the 
messages in this list by dragging them or copying and pasting them into the target folder. If you want to 
maintain the directory structure of restored individual messages, use the Paste Special command.  

You can also restore messages by browsing in the PowerControls main window and dragging and droppin
or copying and pasting from the main window to the target. You do not need to search to restore message
For more information, see Chapter 7, “Re

Performing an Integrity Check on Message
The Find dialog box allows you to perform an integrity check
During the integrity check, PowerControls will verify that it can read all of the properties of the messages. 

To perform an integrity check on messages in the Find dialog box 

2. In the Results area, select the messages for which you want to perform an integrity check
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The Export feature allows you to export mail from an EDB or PST source file to a local or network drive 
destination. You can save exported messages as Microsoft Outlook files (.msg) or plain text files (.txt). 

is o want to copy old email backups into an alternate or non-email 
system. You can export at all levels: an EDB file, a PST file, a mailbox, a folder, and individual messages.  

e ut Exporting Messages 
• with 

x = 2 for the next 
duplicate, and so on. If the subject contains illegal file name characters, the offending characters will 
be replaced with an underscore.  

, 
 also 

LE compound document) can be imported directly into Microsoft Outlook. This file type 
encapsulates the entire message including attachments.   

Distribution List Calendar Item Contact Item Task Item Message and All 
Other Items 

Th  feature can assist customers wh

G neral Information abo
 The file name for an exported message is its subject. A duplicate subject name will create a file 

the same name but with an (x) appended to the filename: x = 1 for the first duplicate, 

• Associated messages and folder properties will not be exported. 

• When exporting individual messages, you have the option to keep the folder/mailbox hierarchy
similar to the paste special feature. When exporting a mailbox or folder, you have the option to
export the subfolders.   

About Message (.msg) and Text (.txt) Export  
The file type for an exported message can be either Microsoft Outlook (.msg) or plain text (.txt).  

Message (.msg) export  
A .msg file (O

Text (.txt) export 
A .txt file will be created with the following information. Note that neither message attachments nor 
message properties will be exported. 

Lis  Name: Subject: Last t Name: Subject: 

riority: 

From: 
Sent: (created date)
To: 
CC: (if present) 
BCC: (if present) 

Location: First Name: Due Date: 
P

Creator Date: Start: 
End: 

Business 
Address: 

Status: 
Percent 

Subject: 

Complete: 

Creation Name: Recurrence:  
(if present) 

Home: Total Work: 
Actual Work: 

Attachment file 
names: 

Members of List: Required 
Attendees: 
Resources: 
Body: 

Category: Owner: Message Body 
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Exporting Messages  
The following instructions show you how to export an EDB file, a PST file, mailboxes, folders, and 
messages from the source pane in the PowerControls main window. They also show you how to export 
messages from the Find dialog box.  

To export an entire EDB file 
1. In the Source pane, select the EDB file.  

2. Do one of the following: 

• On the File menu, click Export. 

• On the toolbar, click the Export button . 

hortcut menu, click Export. • Right-click the EDB file, and on the s

 

3. In the Format box, select MSG or TXT. 

4. In the Export To box, specify the location for the exported EDB file. 

5. Click Export. 

6. In the Export Progress dialog box, verify the EDB file was successfully exported, and click Close. 

To export a PST file, a mailbox, or a folder 
1. In the Source pane, select a PST file, a mailbox or a folder (e.g., Inbox).  

2. Do one of the following: 

• On the File menu, click Export. 

• On the toolbar, click the Export button . 

• Right-click the mailbox or folder, and on the shortcut menu, click Export. 

The Export Mailbox or Export Folder dialog box appears.  
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Export Mailbox dialog box 

 
Export Folder dialog box 

3. In the Format box, select MSG or TXT. 

4. In the Export To box, specify the location for the exported mailbox or folder. 

lick 

 or f  the sp n. In the illustration below er is 
the Inbox. 

5. Select the Export Subfolders check box if you want to export all of the subfolders for the selected 
mailbox or folder. 

6. Click Export. 

7. In the Export Progress dialog box, verify the mailbox or folder was successfully exported, and c
Close. 

The mailbox older appears in ecified locatio , the exported fold
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To export individual messages 
1. In the Source pane, select one or more messages from the message list.  

2. Do one of the following: 

• On the File menu, click Export. 

on • On the toolbar, click the Export butt . 

ion, and on the shortcut menu, click Export. • Right-click the select

 

3. 

4. In the Export To box, specify the location for the exported messages. 

5. Select the Maintain Message Path check box if you want to maintain th directory structure of the 
exported messages. 

fully exported, and click Close. 

pear in the specified location. In the illustration below, the exported messages come 

In the Format box, select MSG or TXT. 

e 

6. Click Export. 

7. In the Export Progress dialog box, verify your messages were success

The messages ap
from the “PC User 1” mailbox.  
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To export individual messages from the Find dialog box 
1. In the Find dialog box, select one or more messages from the message list.  

2. Right-click the selection, and on the shortcut menu, click Export. 

3. Perform steps 3-7 in the preceding section. 

About the Export Progress Dialog Box 
Eac ssages, the Export Progress dialog box appears. This dialog box 
displ

• 

• 

• 

• 

• Warnings or errors encountered during the export process. If an error oc rs on a message, the 
 along with an error message will be displayed. If the message does 

reated) and message sender will be displayed instead. 

xported 

h time you attempt to export me
ays the following information:  

Source and target 

Export start time 

Number of folders to export 

Number of messages to export 

cu
message subject and source path
not have a subject, the date (c

• Total folders and messages successfully e

 

Notes
• ls can recover from, such as a corruption that prevents it from 

trols will log an error, stop processing that message, and 
continue. 

• If an error occurs from which Po erControls cannot recover, such as a major corruption error, 
PowerControls will log an error to the Export Progress dialog box and stop exporting. 

:  
If an error occurs that PowerContro
getting a message property, PowerCon

w
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Chapter 7: Restoring Exchange Data 
e quick look at restoring your Exchange database, so you 
 e second part of this chapter provides examples of 

restoring messages, folders, mailboxes, and even an entire EDB file to the desired destination. 

herwise noted), even though 

Quick Look at Restoring Your Exchange Data 
st rce EDB or PST file to a target destination is a simple process. Just drag and drop 

ste/Paste Special commands.  

e Data in Three Easy Steps 
o ailbox, or a folder from the Source pane and paste it to any target 

st erve the directory structure of all restored messages. When restoring 
vi  

To r
1. 

. 

3. In the Copy Progress dialog box, verify that your messages were successfully copied, and click Close. 

To restore individual messages with Copy-Paste Special  
1. In the Source pane or Find dialog box, copy messages from the message list. 

2. In the Target pane, use Paste Special to paste the messages into a folder, mailbox, PST root, or 
Exchange server root. 

3. In the Copy Progress dialog box, verify that your messages were successfully copied, and click Close. 

Tip: Use the Paste Special command to retain the directory structure of messages copied from the Find 
dialog box, because messages in this dialog box often come from several source locations. 

To restore a folder, a mailbox, an EDB file, or a PST file  
1. In the Source pane, copy a folder, a mailbox, an EDB file, or a PST file. 

2. In the Target pane, paste the copied item into a folder, mailbox, PST root, or Exchange ser er root. 

e Copy Progress dialog box, verify that your messages were successfully copied, and click Close. 

Not s 
from

• 

Th first part of this chapter provides you with a 
can begin to use PowerControls immediately. Th

Note: The concepts in this chapter apply to both EDB and PST files (unless ot
all of the examples of sources are EDB files.  

Re oring data from a sou
or use the Copy and Pa

Restoring Your Exchang
If y u copy an EDB file, a PST file, a m
de ination, PowerControls will pres
indi dual messages, you must use the Paste Special command to preserve their directory structure. 

estore individual messages with Copy-Paste  
In the Source pane or Find dialog box, copy messages from the message list. 

2. In the Target pane, paste the messages into a folder

v

3. In th

e: You cannot open the same PST as a Source and Target. In addition, you cannot restore message
 a PST file to an Exchange Server root node. 

To restore data even faster, use drag-and-drop 
Example: To restore an entire EDB file, drag it to the target Exchange server root. 
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Limits for PST and Folder Targets 
When restoring Exchange Data to a target PST or folder, PSTs have the following limits:  

2 GB PST Limit  
When a target PST file reaches 1.8 GB, PowerControls will create a new PST for the additional messages. 
The new PST file will have the same name as the original target PST file, plus an appended number in 
parentheses: Personal Folders (1), Personal Folders (2), and so on. PowerControls will create the folder 
path in the new PST and continue to restore Exchange data where it left off. 

Note: The 1.8 GB limit applies only to PST files created by Microsoft Outlook XP and earlier. This limit 
does not apply to the new type of PST files created by Microsoft Outlook 2003. 

16,383 Messages Per Folder (e.g., Inbox) Limit 
When a target folder (e.g., Inbox) reaches 16,383 messages, PowerControls will create a new PST folder 
for the additional messages. The new folder will have the same name as the original target folder plus an 
appended number in parentheses: Inbox (1), Inbox (2), and so on. PowerControls will create the folder path 
in the new folder and continue to restore Exchange data where it left off. 

Note: If you have upgraded the PST file to a large table format, the PST can hold 64,000 messages per 
folder. However, when a target folder (e.g., Inbox) reaches 16,383 messages, PowerControls will still 
create a new PST folder for the additional messages. 

To turn off the preference setting for the PST messages per folder limit 
If you do not want PowerControls to create new folders when the number of messages reaches 16,383, do 
the following:  

1. On the Edit menu, click Preferences.  

2. In the PowerControls Preferences dialog box, click the Options tab, and then clear the Create new 
PST folders when PST message/folder limits are reached check box. 

Note: If you turn off the preference, all messages above the messages per folder limit will fail to copy 
correctly, and the PST file may become corrupt. 

About Restoring Messages to an Exchange Server 
You must have sufficient access rights to all of the Exchange mailboxes you are trying to restore messages 
to. Keep in mind that you can connect to only one mailbox at a time.  

Restoring Messages to Exchange 2000/2003 
In Exchange 2000/2003, the permission that controls whether or not any mailbox can be copied to is Full 
Mailbox Access. You must have Full Mailbox Access set to “Allow” in order to copy to a mailbox other 
than the one you logged in under. 

Restoring Messages to Exchange 5.5 
In Exchange 5.5, the account you are logged in under needs an Exchange Service Account Administrator 
rights or role. As long as you copy this role to your account, you can restore messages to any mailbox.  
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About the Copy Progress Dialog Box 
Each time you attempt to restore messages to the Target pane, the Copy Progress dialog box appears. Thi
dialog box displays the following information about the copy operation:  

s 

to or failed to connect to when copying to an Exchange 
server 

• Time of copy operation 

• Number of messages, associated messages, and folders 

• Errors, if any 

• Mailboxes that PowerControls connected 

• Copy results 

 

Important Note: Viewing the copy results in Copy Progress dialog box is especially important when 

displays only one mailbox at a time in the Target pane; therefore, the only way you will know if all of the 
s 

restore messages to, PowerControls 
About Restoring Messages to an 

attempting to restore multiple mailboxes to an Exchange server root node. That’s because PowerControls 

mailboxes were successfully copied to the Exchange server will be to look at the copy results listed in thi
dialog box.  

If you do not have full access rights to the mailboxes you are trying to 
will be unable to connect to the mailboxes. For more information, see “
Exchange Server” on page 160. 
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Creating, Renaming, and Deleting Folders in the Target Pane 
The Target pane has folders in which you can place your restored messages. However, you may wish to 
create new folders for your messages. You can also rename or delete any folder in the Target pane. 

• Right-click and on the shortcut menu, click New Folder. 

• Right-click and on the shortcut menu, click Rename. 

• Press Ctrl+R. 

3. 

To delete a folder in the Target pane 

• On the Edit menu, click Delete. 

To create a new folder in the Target pane 
1. In the Target pane, select a folder, a PST root node, or an Exchange mailbox.  

2. Do one of the following: 

• On the Edit menu, click New Folder. 

• Press Ctrl+N. 

3. In the Create New Mail Folder dialog box, name the folder and click OK. A subfolder is created in 
the target folder. 

To rename a folder in the Target pane 
1. In the Target pane, select a folder.  

2. Do one of the following: 

• On the Edit menu, click Rename. 

Type a new name for the folder. 

Note: You can also rename a PST root. 

1. In the Target pane, select a folder.  

2. Do one of the following: 

• Press the Delete key. 
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Copying and Pasting or Dragging and Dropping 

 c ce pane or Find dialog box 
lder, a mailbox, or the entire EDB file.  

ind dialog box, you can only select messages. 

dit menu, click Copy. 

• Right-click the selected item(s), and on the shortcut menu, click Copy. 

• Click the Copy Mail Item button 

In PowerControls, you can restore data to the Target pane by using Copy-Paste, Copy-Paste Special, or 
Drag-and-Drop. 

To opy an item in the Sour
1. In the Source pane or Find dialog box, select messages, a fo

Note: In the F

2. Do one of the following: 

• On the E

on the toolbar. 

• Press Ctrl +C. 

To paste an item in the Target pane 
1. In the Target pane, select a folder, a mailbox, the PST root node, or the Exchange root node. 

2. Do one of the following: 

• On the Edit menu, click Paste. 

• Right-click the selected item, and on the shortcut menu, click Paste or Paste Special. For more 
information on using the Paste Special command, see “Restoring Messages with Paste Special” on 
page 166. 

• Click the Paste button  on the toolbar. 

tem from the Source pane into a folder in the Target pane. Dragging and dropping achieves 

ht-clicking a source item 
1. In the Source pane, select one or more messages. 

2. Right-click the selected messages and drag them to a folder in the Target pane. 

3. When you let go of the mouse, a shortcut menu appears. On the shortcut menu, click Paste or Paste 
Special. For more information on using the Paste Special command, see “Restoring Messages with 
Paste Special” on page 166. 

• Press Ctrl + V (Paste) or Ctrl-Y (Paste Special). 

To use drag-and-drop  
• Drag an i

the same results as copying and pasting. 

To use drag-and-drop when rig
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Examples of Restoring Your Exchange Data 
This section provides examples of restoring messages, folders, mailboxes, and even an entire EDB file to
the desired destination. In each case, it provides guidelines for restoring messages. 

 

oth EDB and PST files (unless otherwise noted), even though 
o

ith Copy-Paste  
The lo ore individual messages to a folder in a target PST file or 
Exchange Server by using Copy-Paste. Keep in mind that using Drag-and-Drop achieves the same results. 

Guidelines for Restoring Messages 
1. u ages from the message list in the Source pane or the Find dialog box.  

opy-Paste to restore individual messages to a PST root node, an 
change mailbox. However, you can use Paste Special to restore 
ns. 

 Copy-Paste to restore individual messages does not preserve the directory 
u want to preserve the directory structure of restored individual 

s

: Paste Special” on page 166. 

To restore messages with Copy-Paste 
 box, copy messages from the message list. 

Note: The concepts in this chapter apply to b
all f the following examples are EDB files. 

Restoring Messages w
fol wing instructions show you how to rest

Yo  can copy mess

2. You can use Drag-and-Drop or Copy-Paste to restore individual messages to a folder in the Target 
pane.  

3. You cannot use Drag-and-Drop or C
Exchange server root node, or an Ex
individual messages to these locatio

4. Using Drag-and-Drop or
structure of the restored messages. If yo
me sages, use Paste Special.  

Tip  For information on Paste Special, see “Restoring Messages with 

1. In the Source pane or Find dialog

 

2. In the Target pane, paste the messages into a folder (e.g., Inbox) in the target PST file or Exchange 
Server.  
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3. In the Copy Progress dialog box, verify that your messages were successfully copied. You can also 

 to print the copy report. 

4. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  

es with Copy-Paste 
pear in the target folder. 

print or save the copy report by doing one of the following. 

• Click Print

• Click Save to save the copy report as a text file. 

Results of Restoring Messag
All unduplicated messages will ap

 
Exa le
 

mp  1: Pasting messages into a folder (Inbox) in the Target pane 

 
Example 1: Results of pasting messages into a folder (Inbox) in the Target pane 
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Restoring Messages with Paste Special 
You can use the Paste Special command to preserve the directory structure of restored individual messages.
The Paste Special command is especially useful when restoring messages from the message list in the Find
dialog box, since these messages often come from several source locations. 

 
 

aste Special  
1. You can use the Paste Special command to restore individual messages to any target destination. Using 

structure of the restored messages.   

 each 

6. ot node, the Paste Special code will attempt to connect to each 

Not

er with Paste Special 
esent each mailbox. 

are 

Guidelines for Restoring Messages with P

the Paste Special command preserves the directory 

2. You can use the Paste Special command to restore individual messages only. You cannot use the Paste 
Special command to restore an entire EDB file, a mailbox, or a folder.  

3. You cannot use Paste Special to restore messages to a public folder. 

4. If the target is a PST root node or folder, PowerControls will create a folder to represent
mailbox. Each mailbox will be a subfolder of the folder the user selected for the Paste Special 
operation. 

5. If the target is an Exchange Server mailbox or folder, PowerControls will copy all messages to the 
target. Each mailbox will be a subfolder of the folder the user selected for the Paste Special operation. 

If the target is an Exchange Server ro
mailbox one at a time and copy each message to its corresponding mailbox and folder. If the folder 
does not exist, it will be created. If the mailbox does not exist, PowerControls will log an error in the 
copy results, skip the entire mailbox, and continue the Paste Special operation.   

e: You cannot restore messages from a PST file to an Exchange Server root node. 

To restore messages to a PST root or fold
hIf t e target is a PST root node or folder, PowerControls will create a folder to repr

Each mailbox will be a subfolder of the folder the user selected for the Paste Special operation. 

1. In the Source pane or Find dialog box, copy messages from the message list. 

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC User 3) 
copied from the message list in the Find dialog box. 

 
Copying messages from the Find dialog box 
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2. In the Target pane, use Paste Special to paste the messages into a PST root node or folder.  

3. In the Copy Progress dialog box, verify that your messages were successfully copied. You can also 
n of the following. 

 return to the PowerControls main window.  

Results of Restoring Messages to a PST Root Node or Folder with Paste Special  
All unduplicated messages will appear in the target destination, and their directory structure will be 
preserved.  

pri t or save the copy report by doing one 

• Click Print to print the copy report. 

• Click Save to save the copy report as a text file. 

4. In the Copy Progress dialog box, click Close to

 
Example 2: Using Paste Special on a target PST root node 
 

 
Example 2: Results of using Paste Special on a target PST root node 
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Example 3: Using Paste Special on a target PST Inbox  
 

 
Example 3: Results of using Paste Special on a target PST Inbox 
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To estore messages to an Exchange server mailbox or folder with Paste Special  r
If the target is an Exchange Server mailbox or folder, PowerControls will copy all messages to the target. 

1. In the Source pane or Find dialog box, copy messages from the message list. 

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC User 3) are 
pi

Each mailbox will be a subfolder of the folder the user selected for the Paste Special operation. 

co ed from the message list in the Find dialog box. 

 

Paste Special to paste the messages into an Exchange mailbox or folder. 

alog box, review your results to make sure all the messages were copied to the 
n also print or save the copy report by doing one of the following. 

he copy report. 

e copy report as a text file. 

alog box, click Close to return to the PowerControls main window.  

Copying messages from the Find dialog box 

2. In the Target pane, use 

3. In the Copy Progress di
target destination. You ca

• Click Print to print t

• Click Save to save th

4. In the Copy Progress di
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Results of Restoring Messages to an Exchange Server Mailbox or Folder with Paste Special 
Each mailbox will be a subfolder of the target destination, and all unduplicated messages will be restored. 
In addition, their directory structure will be preserved. 

 
mple 4: Using Paste Special on a target Exchange mailbox Exa

 

 
Exa ple 4: Results of using Paste Special on a target Exchange mailbox m
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Example 5: Using Paste Special on a target Exchange folder (e.g., Inbox) 
 

 
Example 5: Results of using Paste Special on a target Exchange folder (e.g., Inbox) 
 

   171



Chapter 7: Restoring Exchange Data 

To restore messages to an Exchange server root node with Paste Special  
If the target is an Exchange Server root node, PowerControls will attempt to connect to each mailbox one a
a time and copy each message to its corresponding mail

t 

 
box and folder. If the folder does not exist, it will 

be created. If the mailbox does not exist, PowerControls will log an error in the Copy Progress dialog box,
skip the entire mailbox, and continue the Paste Special operation.  

Important Note: The source mailbox must exist on the target Exchange server, and you must have full 
mailbox access rights to all of the Exchange mailboxes you are trying to restore messages to. For more 
information on access rights, see “About Restoring Messages to an Exchange Server” on page 160. 

1. Select one or more messages from the message list in the Find dialog box or the Source pane. 

2. In the Source pane or Find dialog box, copy messages from the message list. 

In this example, messages from three different mailboxes (PC User 1, PC User 2, and PC User 3) are 
copied from the message list in the Find dialog box. 

 

Paste Special to paste the messages into an Exchange Server root node.  

g box, verify your results to make sure that your messages from all 
e target destination. You can also print or save the copy report by doing 

opy report. 

• Click Save to save the copy report as a text file. 

5. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  
 

Copying messages from the Find dialog box 

3. In the Target pane, use 

4. In the Copy Progress dialo
mailboxes were copied to th
one of the following. 

• Click Print to print the c
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Results of Restoring Messages to an Exchange Server Root Node with Paste Special 
All unduplicated messages will be restored in each mailbox that PowerControls can connect to, and the 
directory structure of the messages will be preserved.   

 
Example 6: Using Paste Special on a target Exchange server root node 

When attempting to restore multiple mailboxes to an Exchange server root node, you must look at the 
Copy Progress dialog box to verify that your messages from all mailboxes were successfully copied to the 
Exchange server. That’s because PowerControls displays only one mailbox at a time in the Target pane. 

 
Example 6: The Copy Progress dialog box reports that PowerControls was able to connect to all mailboxes 
and successfully copy all messages to Exchange server 
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Restoring a Folder  
The following instructions show you how to restore a folder to any target destination by using Copy-Paste. 
Keep in mind that using Drag-and-Drop achieves the same results.  

Guidelines for Restoring a Folder 
1. You can use Drag-and-Drop or Copy-Paste to restore a folder to a target PST root node or folder, or

to an Exchange server mailbox or folder. If the folder does not exist in the target destination, it will b
created.   

 
e 

es from a priv folder to 
a public folder. 

4. e a folder. You can use the Paste Special 
command to restore individual messages only. 

To restore a folder 
1. In the Source pane, copy a folder (e.g., Inbox). 

2. You cannot restore a folder to an Exchange server root node. 

3. You cannot restore a priv folder to a public folder. But you can restore messag

You cannot use the Paste Special command to restor

 

h box, or PST root node. 

l 
ailboxes were copied to the target destination. You can also print or save the copy report by doing 

one of the following. 

• Click Print to print the copy report. 

• Click Save to save the copy report as a text file. 

4. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  
 

2. In t e Target pane, paste the folder into a folder, mail

3. In the Copy Progress dialog box, verify your results to make sure that your messages from al
m
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Results of Restoring a Folder 
All unduplicated messages in the folder will be restored and their directory structure will be preserved.  
If the folder does not exist in the target destination, it will be created.  

 
Example 7: Pasting a folder in a target destination (e.g., Exchange mailbox) 
 

 
mple 7: Results of pasting a folder in a target destination (e.g., Exchange mailbox) Exa

Note: No folder is created because the copied folder (Inbox) already exists in the target Exchange mailbox. 
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Restoring a Mailbox  

ults.   

2. If you restore a mailbox to a target PST root node: Messages from folders in the source PST are 
ges from the source Inbox are restored 

to the target Inbox). If a corresponding folder does not exist in the target destination, it will be created.  

3.  mailbox to a to a target PST folder, or to an Exchange Server, mailbox, or 
folder: If the mailbox does not exist in the target destination, a folder with its name will be created.  

x to a target Exchange server root node, the source 
mailbox must exist on the target Exchange server, and you must have full mailbox access rights to all 

ailboxes you are trying to restore messages to. For more information on access 
hange Server” on page 160. 

4. You cannot restore a mailbox to a public folder. But you can restore messages from a mailbox to a 
public folder. 

The following instructions show you how to restore a mailbox to any target destination by using Copy-
Paste. Keep in mind that using Drag-and-Drop achieves the same res

Guidelines for Restoring a Mailbox 
1. You can use Drag-and-Drop or Copy-Paste to restore a mailbox to a target PST root node or folder, 

or to an Exchange Server root node, mailbox, or folder.  

restored to corresponding folders in the target PST (e.g., messa

If you restore a

Important Note: If you want to restore a mailbo

of the Exchange m
rights, see “About Restoring Messages to an Exc

5. You cannot use the Paste Special command to restore a mailbox. You can use the Paste Special 
command to restore individual messages only. 

To restore a mailbox 
1. In the Source pane, copy a mailbox (e.g., PC User 1). 

 

2. 

3. th our results to make sure that your messages from all 
ail n also print or save the copy report by doing 
e 

• Click Save to save the copy report as a text file. 

4. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  

In the Target pane, paste the mailbox into a folder, mailbox, PST root node, or Exchange server root 
node. 

In e Copy Progress dialog box, verify y
m boxes were copied to the target destination. You ca
on of the following. 

• Click Print to print the copy report. 
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Results of restoring a mailbox  

ame will be created. However, if 
you restore a mailbox to a target PST root node, a mailbox will not be created. Instead, messages from 
folders in the source PST are restored to corresponding folders in the target PST.   

All unduplicated messages in a mailbox will be restored and their directory structure will be preserved.  
If the mailbox does not exist in the target destination, a folder with its n

 
Example 8: Pasting a mailbox into a PST root node 
 

 
Example 8: Results of pasting a mailbox into a PST root node: Messages from folders in
are restored to corresponding folders in the target PST. 

 the source PST 
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Restoring an EDB File 
py-

 

e Paste 
al 

Important Note: If you restore an EDB file to a target Exchange server root node, the source mailbox must 
ge 

mai
Restoring Messages to an Exchange Server” on page 160. 

To r
1. 

3. select the Exchange Server root node.  

ed to the 
You can also print or save the copy report by doing one of the following. 

• Click Print to print the copy report. 

• Click Save to save the copy report as a text file. 

6. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  

Results of restoring an EDB file 
PowerControls will attempt to connect to each mailbox in the Target pane one at a time and copy each 
message to its corresponding mailbox and folder. If the folder does not exist, it will be created. If the 
mailbox does not exist, PowerControls will log an error in the Copy Progress dialog box, skip the entire 
mailbox, and continue the operation. 

The following instructions show you how to restore an entire EDB file to any target destination with Co
Paste. Keep in mind that using Drag-and-Drop achieves the same results.  

Guidelines for Restoring an EDB File
1. It is recommended that you restore an EDB file to a target Exchange Server root node.  

2. You can use Drag-and-Drop or Copy-Paste to restore an entire EDB file. You cannot use th
Special command to restore an EDB file. You can use the Paste Special command to restore individu
messages only. 

exist on the target Exchange server, and you must have full mailbox access rights to all of the Exchan
lboxes you are trying to restore messages to. For more information on access rights, see “About 

estore an EDB file 
In the Source pane, select the EDB file. 

2. On the Edit menu, click Copy. 

In the Target pane, 

4. On the Edit menu, click Paste. 

5. In the Copy Progre
target destination. 

ss dialog box, review your results to make sure all the messages were copi
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Restoring to Public Folders 
n 

u connect to an 
Exchange target. You will see those folders that you have permission to see.  

Guidelines for Restoring to Public Folders 
1. You can restore folders from a pub.edb database to a public folder target. All public folder permissions 

will be transferred to the target folders. However, folder permissions may not transfer if the version of 
the source Exchange server is different than the version of the target Exchange server. 

2. You can restore messages from any database source or search results to a public folder target.  

3. You cannot restore a folder or mailbox from a priv database to a public folder target. But you can 
restore messages in a folder or mailbox to a public folder. 

4. You cannot use Paste Special when restoring messages to a public folder target. 

vailable at the command line. 

To restore messages to a target Public Folders 
1. In the Source pane or Find dialog box, copy messages from the message list. 

2. In the Target pane, paste the messages into the target root public folder or a folder in the public folder.  

3. In the Copy Progress dialog box, verify that your messages were successfully copied. You can also 
print or save the copy report by doing one of the following. 

• Click Print to print the copy report. 

• Click Save to save the copy report as a text file. 

4. In the Copy Progress dialog box, click Close to return to the PowerControls main window.  

ase. 

. In the Target pane, paste the folder into the target root public folder or a folder in the public folder.  

3. In the Copy Progress dialog box, verify that your messages were successfully copied. You can also 
print or save the copy report by doing one of the following. 

• Click Print to print the copy report. 

• Click Save to save the copy report as a text file. 

4. In the Copy Progress dialog box, click Close to return to the PowerControls main window. 

The following instructions show you how to restore messages or public folders to a public folder target. A
option to open public folders is available upon connection to an Exchange server.  

Important Note: PowerControls will open public folders and your mailbox when yo

Note: The ability to restore to public folders is also a

To restore a folder from a public database to a target Public Folders 
1. In the Source pane copy a folder from a public datab

2
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Results of restoring to Public Folders 

• All public folder permissions are transferred to the target folders. However, folder permissions may not 
xchange server is different than the version of the target Exchange 

• 
folders may be merged with permissions for parent folders. 

When you restore folders from a pub.edb database to a public folder target, the following occurs:  

transfer if the version of the source E
server. 

• The Exchange user doing the restore will be added to all public folder permissions with owner rights. 

If you have IFS (also known as “M:drive”) enabled on your Exchange server, permissions for child 
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Chapter 8: Using the Command Line  
The command line feature allows you to easily batch repetitive processes such as multiple copy and export 
tasks without initiating the PowerControls user interface. This feature is extremely beneficial in 
PowerControls production environment implementations. 

Command Line Syntax 
The syntax is as follows: 

<< >>  Required for all operations 

< >      Required for copy/export operations 

[ ]         Optional 

Command Line Syntax 
PowerControls <<Operation>> [Operation options] <<Source Store>> [Source options] <Source Folder 
Path> <Target Store>  <Target Folder Path> 

 
<Operation> 
 -Copy 
 -Export 
 -List (report information about the database) 
 -Integ (Integrity Check) 
 -h (help) 
 
[Operation options] 
 -f <format>  
  format: 
   :msg – messages will be exported as .msg (.msg is the default) 
   :txt – message will be exported as .txt 
 -r 
  export/copy subfolders 
 
 -o <filename> 
  name of file to output progress information to default is CON 
 

Note: If the file exists, PowerControls will append to the output progress file. If the file does not 
exist, PowerControls will create it. 

 
 -da  <mm/dd/yyyy> 
  Process messages dated on or after this date 
 -db <mm/dd/yyyy > 
  Process message dated on or before this date 

 
 -v verbose 
 
<Source Store> 
 Full path of EDB file or PST file 
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[Source options] 
 -l <Log file path> 
 -t <Temp file path> 
 
< Source Folder Path > 

full path, including mailbox to the source folder to be copied/exported or $ROOT for root 
store fol

 
data der 
<Target Store> 

  Ex. Pcpdc;jJones 

 
 
Note: The Target Store is not needed for export. 
 
[Target  options] 
 -pub public folders 
 
<Target Folder Path> 
 Full path, including mailbox to the target folder to be copied/exported to or $ROOT for root 
datastore folder 
 
Note: Only message containers (i.e., mailboxes, folders, entire EDB) can be selected for copy/export.  
All messages contained will be copied/exported. Individual messages can not be selected from the 
command line.   

Examples of Using the Command Line 
The following examples are for copy, export, and list (i.e., report information about the database). 

Example 1

 ServerName;mailbox or Full path of PST  

        Pcpdc;hJohnson 
       C:\archive.pst 

: Copy pcuser1’s inbox and all subfolders from c:\pcdata.edb to the inbox in c:\target.pst. 
c:\out1.txt will contain the copy report. 

powercontrols -copy -r -o c:\out1.txt c:\pcdata.edb -t c:\ pcuser1\inbox c:\target.pst $ROOT 

<Operation> Explanation 
-copy Perform a copy operation 
  
[Operation options] Explanation 
-r copy subfolders 
-o c:\out1.txt output report file name 
  
<Source Store> Explanation 
c:\pcdata.edb path to the database file name 
 
[Source options] Explanation 
-t c:\ temporary file path 
 
<Source Folder Path> Explanation 
pcuser1\inbox source folder to copy 
  
<Target Store> Explanation 
c:\target.pst target data store 
 
<Target Folder Path> Explanation 
$ROOT copy to the root folder of the data store 

 182 



Ontrack® PowerControls™ 4.0 User Guide 

 
Example 2: Copy pcuser1’s inbox and all subfolders from c:\pcdata.edb to user1’s inbox on exchange 
server pcpdc. c:\out1.txt will contain the copy report. 
 
powercontrols -copy   -r   -o c:\out2.txt   c:\pcdata.edb   -t c:\   pcuser1\inbox   pcpdc;user1   inbox 

<Operation> Explanation 
-copy perform a copy operation 
  

Explanation [Operation options] 
-r copy subfolders 
-o c:\out2.txt output report file name 
  
<Source Store> Explanation 
c:\pcdata.edb path to the database file name 
 

Explanation [Source options] 
-t c:\ temporary file path 
 
<Source Folder Path> Explanation 
pcuser1\inbox source folder to copy 
  
<Target Store> Explanation 
pcpdc;user1 target data store (Exchange server name and logon 

ID) 
 
<Target Folder Path> Explanation 
inbox copy to the inbox 
 

Example 3: Export pcuser1’s mailbox and all subfolders from pcdata.edb as text to c:\export  

t   -r   -f:txt   -o   c:\out3.txt   c:\pcdata.edb   -t c:\    pcuser1   c:\export 

Explanation 

powercontrols -expor

<Operation> 
- perform an export operation export 
  

Explanation [Operation options] 
-r export subfolders 
-f:txt messages will be exported as .txt 
-o c:\out3.txt export report file name 
  
< Explanation Source Store> 
c:\pcdata.edb path to the database file name 
[Source options] Explanation 
-t c:\ temporary file path 
 
<  Folder Path> Source Explanation 
p  source focuser1 lder to copy 
  
< ExplanationTarget Store>  
NA target data store 
 
<Target Folder Path> Explanation 
c:\export Root folder of the export 
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Example 4: Provides information on the databases including a list of mailboxes. 

ip: Wh t operation, use the -o filename option in order to see the mailboxes. 
therwise, the operation will proceed so fast that you won’t be able to see the mailboxes. 

Explanation 

T en performing the -lis
O
 
powercontrols –list –o c:\mblist.txt c:\priv1.edb 

<Operation> 
-list perform a list operation 
  
[O n s] peratio  option Explanation 
-o li c:\mb st.txt output report file name 
  

Explanation <Source Store> 
c:\priv1.edb path to the database file name 
 

Example 5: Perform an integrity check on and entire EDB. 

nteg -r

Operation> Explanation 

-i  -o c:\output.txt c:\priv1.edb $ROOT 

<
- integ Perform an integrity check on a database 
  
[Operation options] Explanation 
-o c:\\output.txt output report file name 
  
<Source Store> Explanation 
c:\priv1.edb path to the database file name 
  
<Source Folder Path> Explanation 
$ROOT Root of the EDB (entire EDB) 
 
Example 6: Copy a folder from a pub EDB to public folders (only copy messages dated after 01/01/2000) 

ministrator" -pub $ROOT 

Explanation 

 
powercontrols -copy -r -o c:\out2.txt –da 01/01/2000 c:\pub1.edb newsgroups 
"pcvx2000;ad

<Operation> 
-copy perform a copy operation 
  

ons] [Operation opti Explanation 
-r copy subfolders 
-o c:\out2.txt output report file name 
-da 01/01/2000 Only copy messages that were 

date 
created after this 

  
ce Store> <Sour Explanation 

c:\pub1.edb path to the database file name 
 
 

Explanation <Source Folder Path> 
newsgroups source folder to copy 
  

Target Store> Explanation <  
pcvx2000;administrator tore (Exchange server name and logon target data s

ID) 
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<Target Options> Explanation 
-pub C

 
opy to public folders 

 
<Target Folder Path> Explanation 
$ROOT Public folders root 
 

Important Notes: 

• All paths with spaces need to be in quotes. 

oes not exist in the target, PowerCont compatible with Outlook 97, 
 2002. 

• If a PST d rols will create a PST file 
98, 2000, and
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Chapter 9: Reporting 
This chapter shows you how to create reports, view the statistics in the generated reports, and save the 
reports as either tab-delimited or comma-delimited text files. Any data store opened as a source can be the 
source of a report. 

Creating Reports 
PowerControls allows you to generate reports on either an EDB or a PST source data store. The reports 
contain statistics about the data store such as sizes and counts for attachments and messages, and may be 
generated per attachment type, domain, mailbox, database, and date. The Mailbox and Date reports are 
available for Priv EDB data sources only. 

To create one or more reports 
1. In the Source pane, select an EDB or PST data source. 

2. On the File menu, click Create Reports. The Create Reports dialog box appears.  

If you selected a Priv EDB as the source for the report, the list view will display all mailboxes in the 
EDB. If you selected a PST or Pub EDB as the source, the list view will display all folders 
immediately under the root of the PST or Pub EDB. 

 
Create Reports dialog box for a Priv EDB source 
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3. Do one of the following: 

• For Priv EDB: Under Mailboxes, select the mailboxes to be included in the report(s). All 
mailboxes are selected by default. 

• For Pub EDB or PST: Under Folders, select the folders to be included in the report(s). All folders 
are selected by default. 

4. Under Reports, select one or more reports that you would like to create: 

 Attachment Statistics 

 Domain Statistics 

 Messages by Database 

 Messages by Mailbox: This report is available for Priv EDB data sources only. 

 Messages by Date: If you select this report, then specify the appropriate options for received date 
range and date unit (e.g., hour, day, week, month). This report is available for Priv EDB data 
sources only. 

5. Under Message Options, select the appropriate deleted item retention option(s). Both options are 
selected by default. For PST sources, the first option is unselected. You cannot modify the default 
options for PST sources. 

• Include messages in deleted item retention: Select this option to include messages in deleted 
item retention. 

• Include messages not in deleted item retention: Select this option to include messages that are 
not in deleted item retention. In most cases, this option represents most of the messages in the 
source data store. 

6. Click the Generate Reports button. The PowerControls Reports dialog box appears. For more 
information the contents of the reports, see “Viewing Reports” on page 189. 
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Viewing Reports 
The PowerControls Reports dialog box shows the progress of the report generation and also shows the 
reports themselves. This dialog box consists of a tabbed view of the reports, with each tab containing a 
single report. For information on the statistics provided in each report, see the following sections.  

 

Single Instance Storage (SIS) vs. Cumulative Counts 
The Attachment Statistics and Messages by Database reports use the terms “SIS” (Single Instance Storage) 
and “Cumulative” when referring to the number and size of attachments in the data store. The term “SIS” 
counts attachments only once and does not include their duplicates. The term “cumulative” refers to all of 
the attachments or messages, including their duplicates.  

Example: An attachment of type .DOC of size 100 KB is being shared by three messages. As the table 
shows, the SIS size more closely estimates how much of the EDB size is attributed to the attachment.  
The cumulative size more closely estimates how much of the EDB size is attributed to attachments if the 
data store did not have SIS. 

Method of Counting 
Attachments/Messages 

Total # of .DOC 
Attachments 

Total Size of .DOC Files 

SIS Count  1 100 KB 

Cumulative Count  3 300 KB 
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Attachment Statistics Report 
The Attachment Statistics report provides statistics on all of the attachments contained in messages in the 
selected source. The attachments are categorized by extension, which appears in upper case letters (e.g., 
.DOC, .XLS). Attachments without extensions are put into a separate row called “No Extension.” 

Column Heading Description 

Attachment Extension Attachment type by extension (e.g., .DOC, .PPT, .PDF) 

Cumulative Number of 
Attachments Found in Messages 

Cumulative number of attachments of each type found in the 
processed messages 

Cumulative Size of Attachments Cumulative size of attachments of each type found in messages 

Average Attachment Size Cumulative size of attachments of each type divided by the 
cumulative number of attachments found in messages 

Percent of Total by Number Number of attachments of each type divided by total attachments of 
all types 

Percent of Total by Size Total size of attachments of each type divided by the total size of 
attachments of all types 

SIS Number of Attachments  SIS number of attachments of each type. NA for PST sources. 

SIS Size of Attachments  SIS size of attachments of each type. NA for PST sources. 

SIS Percent of Total by Size  SIS size of attachments of each type divided by SIS size of 
attachments of all types in attachment table. NA for PST sources. 
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Domain Statistics Report 
The Domain Statistics report provides statistics on messages grouped by the domain from which the 
messages were sent.  

The domain is determined using the PR_SENDER_ADDRTYPE in combination with the 
PR_SENDER_EMAIL_ADDRESS as follows: 

• If PR_SENDER_ADDRTYPE is “EX” or “SYSTEM,” then it is an exchange message and the domain 
is “internal.” 

• If PR_SENDER_ADDRTYPE is “SMTP”, then the domain is whatever follows the @ in the 
PR_SENDER_EMAIL_ADDRESS property.  

• If PR_SENDER_ADDRTYPE is something else, then the domain is “unknown.” 

Column Heading Description 

Domain The name of the domain (e.g., ontrack.com) from which the message 
was sent. All messages whose domain cannot be determined are 
placed into an “unknown” domain. All Exchange messages are placed 
into an “internal” domain. 

Number of Messages Total count of messages that were received from each domain 

Total Size of Messages Total size of all messages that were received from each domain 

Percent of Total by Number Number of messages from each domain divided by the total number 
of messages from all domains 

Percent of Total by Size Total size of messages from each domain divided by the total size of 
messages from all domains 
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Messages by Database Report 
The Messages by Database report provides statistics on the database that contains the processed messages. 
In the current version of PowerControls, reports are limited to a single EDB or PST, which means the 
database report has only one row of information. For example, the database report for Priv1.edb has one 
row of information listing all message statistics for Priv1.edb and its mailboxes. 

Column Heading Description 

Database (EDB or PST) The database name (e.g., Priv1.edb, Pub1.edb, Outlook XP.pst) 

Cumulative Number of Messages Cumulative number of messages 

Cumulative Size of Messages Cumulative size of all messages processed  

Average Size of Messages Cumulative size of messages divided by cumulative number of 
messages 

Cumulative Size of Attachments Cumulative size of attachments in all messages processed 

SIS Size of Attachments  SIS total size of attachments. This column applies only to EDB 
sources. For PST data stores, this column is NA. 

 
Important Note: The statistics in the Database report refer only to the mailboxes (for a Priv EDB) or the 
folders (for a PST or Pub EDB) you selected in the Create Reports dialog box. The statistics also depend 
on the options you specified in the Message Options area. In other words, unless all mailboxes/folders are 
selected, the Database report will not provide statistics for the entire database. 

 
Create Reports dialog box for a Priv EDB source 
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Messages by Mailbox Report 
The Messages by Mailbox report provides message statistics for all selected mailboxes in a Priv EDB data 
store.  

Note: This report is available only for a Priv EDB. 

Column Heading Description 

Mailbox Name of the mailbox: Display name (alias) 

Number of Messages Total number of messages in the mailbox 

Total Size of Messages Total size of all messages in the mailbox 

Average Size of Messages Total size of messages divided by number of messages 

Total Attachment Size Total size of attachments in all messages in this mailbox.  
Attachments in messages in this mailbox that are also in messages in 
another mailbox are counted in both mailboxes. 

Shared Attachment Size Size of attachments that are found more than once, either multiple 
times in this mailbox or in this mailbox and other mailboxes.  
Calculated as total size of attachments minus the non-shared 
attachment size. 

Non-shared Attachment Size Size of attachments that are not shared with other messages 

Internal Received Messages Received messages of type “EX” or “SYSTEM” 

SMTP Received Messages Received messages of type “SMTP” 

Other Received Messages Received messages not of type “EX,” “SMTP,” or “SYSTEM” 

 
Note: For a definition of “received message,” see the glossary. 
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Messages by Date Report 
The Messages by Date report provides statistics for messages in a date range, such as 1/1/2004 to 1/1/2005, 
and a unit of hours, days, weeks, or months. The report is keyed off of the received date of the message. 

Note: This report is available only for a Priv EDB. 

Column Heading Description 

Hour/Day/Week/Month The date unit that was selected in the Create Reports dialog box. 
Examples are: 

Hour: “12/25/2004 – 9 PM” 

Day: “12/25/2004” 

Week: “12/26/2004 – 1/1/2005” (Weeks start on Sunday and end 
on Saturday.) 

Month: “12/2004” 

Internal Received Messages Received messages of type “EX” or “SYSTEM” 

Total Size of Internal Received 
Messages 

The sum of the internal received message sizes 

SMTP Received Messages Received messages of type “SMTP”  

Total Size of SMTP Received 
Messages 

The sum of the SMTP received message sizes 

Other Received Messages Received messages not of type “EX,” “SMTP,” or “SYSTEM” 

Total Size of Other Received 
Messages 

The sum of the other received message sizes 

 
Note: For a definition of “received message,” see the glossary. 
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Sorting Reports 
Sorting of reports is available after the reporting process has finished. The order in which statistics first 
appear in the PowerControls Reports dialog box is based on the ascending order of statistics in the first 

DOC precedes .TXT). However, you can sort statistics 

To sort the statistics in a report 
 a column heading to sort t appears indicating the 

sort direction. An up arrow indicates the statistics appear in ascending (A-Z) order. A down arrow 
tatistics appea

 of the statis e column heading again. 
Notice that the arrow reverses directions. 

 
The Attachment Statistics report is o
(e.g., .DOC precedes .TXT). If you c  arrow appears and 

orde

If you click the “Number of Attachm nd 
statistics are sorted based on ascendi east 
frequently in the data source appears    

 
ctive re a-separated text file. The report 

name defaults to the name shown on the report tab, without the spaces and with a txt extension (e.g., 
e type def

report active by clicking its tab  
(e.g., Attachment Report, Database Report). 

2. Click Save. 

3. In the Save Report dialog box, specify the name, location, and file type for the report. You may save 
the report as either a tab-separated or comma-separated text file. 

4. Click Save to return to the PowerControls Reports dialog box. 

5. Repeat steps 1-4 for each report you want to save. 

column (e.g., for the Attachment Statistics column, .
based on any column heading. 

3. Click he statistics based on that heading. An arrow 

indicates that the s r in descending (Z-A) order. 

4. To reverse the order tics based on that column heading, click th

An Example of Sorting
riginally sorted based on the ascending order of attachment extensions 
lick the Attachment Extension heading, the down

statistics are sorted in descending r (e.g., .TXT precedes .DOC).  

ents Found in Messages” column heading, the up arrow appears a
ng order. This means that the attachment extension occurring l
first in the report.

Saving Reports
You may save the currently a port as either a tab-separated or comm

MailboxReport.txt). The fil aults to a tab-separated text file. 

To save a report 
1. In the PowerControls Reports dialog box, make the desired 
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Glossary 

BKF An .MTF format backup-to-disk file, which is similar to other archive formats 
such as ZIP or ARJ. Backup software applications that output this file format 

 Backup (the version that shipped with Windows 2000), Windows 
 2003 and XP, and Backup Exec. 

CH
eckpoint is the place marker in the 

EDB.CHK file that indicates which transactions have been committed. 

pdated with information specifying that the transaction was 
successfully committed to the respective EDB file. Separate Exx.chk files are 
maintained for each storage group using ESE (Extensible Storage Engine).   

o live data stores, one for the 

EIS See Exchange Information Store. 

is file, which usually has an EDB extension, contains the mailbox, folders, 

 up 
 being the STM file. 

ation This is the set of files that make up the data store for private mailboxes and 
gle 
change 

ate mailbox data store will consist of the files priv1.edb 
and priv1.stm, and the public folder data store will consist of pub1.edb and 
pub2.stm. 

g
king up Exchange data. All Exchange 

Each storage group uses its own set of transaction log files. For example, if a 
stores, all transactions for all five stores are 

recorded in a single series of transaction log files. You can determine where to 
locate the transaction log files for each storage group. 

Messages Messages are found in the folders of an Exchange Information Store.  
Messages can mean “email,” but Outlook Contacts are also messages, as are 
Appointments, Journal Entries, Sticky Notes, and Tasks. 

MTF Microsoft Tape Format. This is the Microsoft defined format for data on a 
backup tape. It is issued by NT Backup, Windows Backup, and Backup Exec. 

are NT
Backup

K  Checkpoint files (.chk files) are used for recovering (playing) data from 
transaction logs into EDB files. The ch

Whenever data is written to an EDB file from the transaction log, the 
EDB.CHK file is u

Data Store A unified collection of folders and messages contained in a single storage 
medium. A PST file is a data store. An Exchange Information Store is also a 
data store. In a basic case, Exchange has tw
private mailboxes and one for the public folders. 

EDB See Exchange Database. 

Exchange Database Th
and messages you see when connecting to an Exchange server. The Exchange 
Server reads and writes to this file in response to incoming email and events 
from the clients. On Exchange 2000, this is one of the two files that make
the Exchange Information Store, the other

Exchange Inform
Store public folders on an Exchange Server. For Exchange 5.5, this is the sin

Exchange Database file usually named priv1.edb and pub1.edb. On Ex
2000 and 2003, the priv

Lo  Files Transaction log files (.log files) are history files recording server activity. 
These files are useful in restoring and bac
2000 transaction logs are 5 MB in size. 

storage group contains five 
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PAT Patch files (.pat files) are used to record information on page splits in 
Exchange 5.5 through Exchange 2000 (SP1). In Exchange 2000 (SP2) and 
later, the functionality provided by .pat files is incorporated into Exchange log 
files. 

PST Personal Storage file. This file, used by Outlook, contains folders and 
messages that have been retrieved from a user’s Exchange mailbox and copied 
locally. 

Received Messages Messages that have been sent through an Exchange Server to another mailbox. 
Messages in the "Sent Items" folder are copies of messages sent through an 
Exchange Server and are not considered to be “received messages.” Because 
messages in the “Drafts” folder, “Notes” folder, and other similar items are not 
sent through an Exchange server, they too are not considered to be “received.” 

Note: Because recovery software such as PowerControls restores messages 
from a source to an Exchange mailbox without sending them, the messages that 
PowerControls restores are not considered to be "received messages." 

Source Data Store This is the data store from which folders and messages are copied. The source 
is read-only, so items cannot be copied into, deleted from, or changed in the 
Source. 

STM For Exchange 2000 and 2003, this is one of the two files that make up the 
Exchange Information Store, the other being the EDB file. The STM file stores 
certain data for emails that come into the Exchange Server through the POP or 
SMTP port. This email data may eventually get moved into the EDB file over 
time. 

Target Data Store This is the data store to which folders and messages are copied. The target is 
read-write allowing items to be added, deleted, and changed. The target data 
store can be an Exchange server or PST file. 
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